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Random Numbers 
 
Excel provides two tools for generating random numbers as follows: 
 

1. RAND 
2. RANDBETWEEN (You must first activate the Analysis ToolPak) 

 

RAND - The RAND function in Microsoft Excel allows you to generate random numbers in Excel. 
Specifically, type RAND() in a given cell to produce a random number between 0 and 1, as shown. 
 

 
 
Comments 
 

1. RAND is a volatile function, which means it will be recalculated any time the enter key is 
pressed, so the random number constantly changes. To prevent random numbers from 
changing, most people copy and paste them as values.  

 
2. Excel’s RAND function can be used to generate random numbers from the Uniform 

distribution, however, be aware that prior to Excel 2003, this function should not be used 
with large simulation models because the older versions of Excel use the generation 
algorithm which has a relatively small period (less than 1 million numbers), so if your 
model contains hundreds of variables and you are running the simulation tens of 
thousands of times, you can run out of random numbers. This problem has been fixed in 
Excel 2003 and later versions. 

 
3. Note that there is a known bug in Excel 2003 causing the RAND function to return negative 

numbers, which can be negated using the ABS (absolute function). 
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RANDBETWEEN - In Excel 2010, 2007 and 2003, you must first activate Analysis Tool Pack add-in 
as follows. In Excel 2010 and 2007, select File, Options, Add-ins, GO and place a check in the 
check box labeled Data Analysis ToolPak, then click OK. In Excel 2003, select Tools, Add ins,… 
 
The RANDBETWEEN returns a random integer between two specified numbers, as shown. 
 

 
 
 
Suppose you wanted to select 100 random numbers from three different ranges of the 
population. There are several approaches you might take. The first approach might be simply to 
list all possible values, then use RAND to create a random number adjacent to those values, and 
then sort. The screen shots below show the data before and after sorting. Once sorted, simply 
take the desired number of samples from the top of the randomly sorted list, as suggested by the 
top 7 values shaded in the second screen shot. 
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This method takes up a lot of Excel screen real estate, but so what? Excel has millions of rows 
and the generation of such a report is fairly straight forward and fast. Just use the FILL command 
to fill in the necessary ranges, then add RAND and sort – it might take you 2 to 3 minutes. 
 

 
 

Random Numbers Given Three Ranges of Population Data 
 
Another way to generate random numbers is to use RANDBETWEEN, and assigning the 
probability that a random number is selected from a given range based upon the percentage that 
range represents compared to the total population. For example, consider the following 
example: 
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Cells C4 through E5 contain the low and high values for three separate ranges of data making up 
the total population. We start by calculating the number of occurrences in each range (1,111, 
1,277 and 55 in this example), and then calculate the percentage each range represents for the 
total population (45%, 52% and 2% in this example). 
 
Thereafter, a series of RANDBETWEEN functions are used to produce random number triggers 
between 1% and 100% (contained in cells I3 through I22 in this example), and then an IF function 
is used to calculate within which range each random number trigger falls. For example, the first 
random number trigger is 49% (in cell I3), which falls within the second range data. The 
RANDBETWEEN function in cell J3 thusly calculates a random number using the second range of 
data’s low and high values (6,500 and 7,777 in this example), and the first random number 
generated is 7,731 in this example. 
 
This method could theoretically be used to calculate random numbers for many separate ranges 
of data, with each member of the population having an equal chance to be selected.    
 
Download this workbook at www.CarltonCollins.com/5random.xlsx.  
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Consolidating Data in Excel 
 
Consolidating data is a common task for CPAs, and Excel offers a variety of methods for 
performing this task. The particular method you use will probably depend on the layout of your 
data, and you may need to clean, edit or manipulate your data a bit to prepare it for 
consolidation. CPAs often have a need to consolidate data such as budgets, months, 
departments, locations, warehouses and sale representatives. 

 
Following I will explain four different consolidation methods - two methods for consolidating data 
with similar layouts, and two more methods for consolidating data with dis-similar layouts. These 
four methods are as follows: 
 

A. Simple formulas. 
B. Spearing formulas. 
C. The “Data Consolidate Command”. 
D. The “PivotTable Wizard”. 

 

A. Using Simple Formulas To Consolidate Similar Data  
 
The workbook below contains budgets with identical layouts for Departments A, B, C and D. 
The goal is to consolidate these four budgets into a single consolidated budget. 
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1. Insert a New Worksheet on which the consolidation will appear 
 

i. Don’t click the New Sheet or Add Sheet Option - Because there is a better 
and quicker approach. 
 

ii. CTRL + Drag Tab – To insert a new worksheet, select worksheet labeled 
“Dept D”; then use the CTRL + Drag Tab keystroke combination to create a 
duplicate worksheet of Dept D. The advantage is that the data, column 
widths, page footers and headers, and margin settings are all duplicated 
automatically, so you don’t have to create a new page from scratch. 

 

 
 

iii. (The menu method for achieving this same procedure is to right click on 
the tab and select Move or Copy, but CTRL + Drag Tab is quicker.) 

 
iv. Clean the Page – Clean the new worksheet by deleting the data in the grid 

area, so that new formulas can be inserted.  
 

     
 

v. Re-label – Change the worksheet label in Cell A1 and on the Worksheet 
Tab to read “consolidated”. 
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2. Formula – In cell B5, enter a formula adding the B5 cells in the four budget sheets. 
The formula should look like this: 

 

='Dept A'!B5+'Dept B'!B5+'Dept C'!B5+'Dept D'!B5 
 

3. Copy – Copy the formula down and across to complete the consolidation, and you 
are done. 
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B. Using Spearing Formulas To Consolidate Similar Data  
 

The workbook below contains budgets with identical layouts for Departments A, B, C and D. 
The goal is to consolidate these four budgets into a single consolidated budget. 

  

 
 

1. Insert a New Worksheet on which the consolidation will appear 
 

i. Don’t click the New Sheet or Add Sheet Option - Because there is a better 
and quicker approach. 
 

ii. CTRL + Drag Tab – To insert a new worksheet, select worksheet labeled 
“Dept D”; then use the CTRL + Drag Tab keystroke combination to create a 
duplicate worksheet of Dept D. The advantage is that the data, column 
widths, page footers and headers, and margin settings are all duplicated 
automatically, so you don’t have to create a new page from scratch. 
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iii. (The menu method for achieving this same procedure is to right click on 
the tab and select Move or Copy, but CTRL + Drag Tab is quicker.) 

 
iv. Clean the Page – Clean the new worksheet by deleting the data in the grid 

area, so that new formulas can be inserted.  
 

     
 

v. Re-label – Change the worksheet label in Cell A1 and on the Worksheet 
Tab to read “consolidated”. 

 

     
 

2. Formula – In cell B5, enter a formula adding the B5 cells in the four budget sheets. 
The formula should look like this: 

 

=SUM('Dept A:Dept D'!C5) 
 
I use the mouse to accomplish this step. Start by typing “=SUM(“, then click on cell B5 in 
Dept A, hold the shift key down, and click cell B5 in Dept D.  
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3. Copy – Copy the formula down and across to complete the consolidation, and you 
are done. 
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C. Using the “Data Consolidate Command”  
To Consolidate Dissimilar Similar Data 
 

The workbook below contains dis-similar budgets for Departments A, B, C and D. 
Specifically, the four worksheets contain budgets for separate departments, and some 
budgets contain more rows and different row descriptions than others. The goal is to 
consolidate these four departmental budgets using the Consolidate Command. 

  

 
 

1. Create A New Worksheet – Insert a new worksheet. Because there is no need to 
duplicate a template from another worksheet you might be tempted to use the New 
Sheet button this time; however, this approach does not duplicate the worksheet’s 
page footers, headers or margin settings. Therefore I would still recommend that you 
use the CTRL + Drag Tab method as described in examples 1 & 2 above to create a 
new sheet, and I would then eliminate the data on the new sheet by deleting those 
columns that contain data. 
 

2. Label – As before, label the new worksheet in Cell A1 and on the Worksheet Tab to 
read “Consolidated”. 
 

3. Select Cell – Select a blank cell on the new worksheet such as B3.  
 

4. Use the Consolidate Command - From the Data tab, select Consolidate to display the 
Consolidate dialog box as pictured below. Click the Cell Chooser button, then highlight 
the data only on Dept A, click Enter, and then click Add. Repeat this process for Dept 
B, Dept C and Dept D. 
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5. Check the check boxes to use Labels in the Top Row and Left Column.   
 

6. Finish – Click OK to produce the results. 
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7. Add Totals and Formatting - Highlight your data and expand the selection to include 

a blank bottom row and blank right column. Click the AutoSum tool, add formatting 
and you are done. 

 

 
 

Comments: 
 

 Row Descriptions - Note that the consolidation works only to the extent that the 
different worksheets contain the same row descriptions. If your four department 
heads had used the descriptions: Rent, Rent Exp., Rent Expense, and Rental Expense, 
then those rows would not actually be consolidated, rather they would be shown as 
four separate rows in the resulting consolidation. However, because all four 
department heads did use the phrase Rent to describe that row, the four respective 
rent rows were properly consolidated.  

 

 Account Numbers – As an option, you might insert account numbers to the left of the 
row descriptions to consolidate dissimilar information which contains dis-similar row 
descriptions.  
 

 To Update – To update the results, place your cursor in the upper left hand corner of 
the Consolidation range, and rerun the Consolidate command. If the resulting report 
is a different size, you may need to clean up your data and reapply totals.  
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 Consolidate Different Workbooks – Excel can also consolidate data from different 
workbooks. The procedure is exactly the same except that you use the Browse button 
instead of the Cell Chooser button to point to your data ranges.  

 
The Problem with Data Consolidate 
 
The problem with Data Consolidate occurs when you attempt to change the source data, for 
example when you insert a new row in Dept A; a comedy of errors ensues as follows: 
 

1. When you change the source data, the consolidated report does not update automatically. 

2. Pressing the Refresh button does nothing. 

3. To update the consolidated report, you must rerun the data consolidate command. But upon re-
running this command, you find that your cursor needs to be in the exact same location when 
you ran it last time. 

4. You also find that you need to erase the previous data before re-running the Data Consolidate 
command. 

5. Next you find that in Excel 2003, 2007 and 2010, you need to re-adjust your consolidating range 
for Dept A because the tool did not automatically expand the selection when the row was 
inserted in Dept A. (This issue has been corrected in Excel 2013.)  

Because source data tends to change frequently, you are probably better off using the next 
method to consolidate your data - the PivotTable and Chart Wizard method.  
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D. Using A PivotTable To Consolidate Dissimilar Similar Data 
 
The workbook below contains the same dis-similar budget data used in example 3 above. The four 
worksheets contain budgets for separate departments, and some budgets contain more rows and 
different row descriptions than others. The goal is to consolidate these four departmental budgets using 
the PivotTable approach. 

  

 
 

1. Create A New Worksheet – Start by inserting a new worksheet. (Because there is no need 
to duplicate a template from another worksheet you might be tempted to use the New 
Sheet button this time; however, this approach does not duplicate the worksheet’s page 
footers, headers or margin settings. Therefore I would still recommend that you use the 
CTRL + Drag Tab method as described in examples 1 & 2 above to create a new sheet, and 
I would then eliminate the data on the new sheet by deleting those columns that contain 
data.) 
 

2. Label – Label the new worksheet in Cell A1 and on the Worksheet Tab to read 
Consolidated. 
 

3. Select Cell – Select a blank cell such as B3.  
 

4. Add the PivotTable Wizard to Your Quick Access Toolbar – The PivotTable Wizard in Excel 
2003 allows you to pivot multiple consolidation ranges, but for unknown reason this tool 
is hidden in later versions of excel. Therefore, in Excel 2013, 2010 and 2007, you must first 
customize your Quick Access toolbar and insert the icon titled PivotTable and PivotChart 
Wizard as shown below.  
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To add this tool, right-click your Quick-Access toolbar, select Customize Quick Access 
Toolbar, select the option to View All Commands, locate the PivotTable and PivotChart 
Wizard icon and add it to your toolbar. The resulting toolbar will appear as follows.  .  

 

 
 

5. Run the PivotTable Wizard – Click the PivotTable and PivotChart Wizard icon to display 
the PivotTable and PivotChart Wizard dialog box as shown below. Choose the Multiple 
consolidation ranges option and click Next, and Next again. The dialog box on the right 
should now be displayed. 

 

   
 

Click the Cell Chooser button, then highlight the data only on Dept A, click “Enter”, and 
then click “Add”.  
 

 
 
Repeat this process for Dept B, C and D until the PivotTable Wizard appears as follows. 
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6. Finish – Click “FINISH” to produce the results. 
 

 
 

7. Add Formatting - Highlight your data and add comma formatting with no decimals, adjust 
the columns widths to taste, center the column headings; then you are done. 
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Comments: 
 
The PivotTable Wizard approach is superior to the Data Consolidate approach for many reasons as 
follows: 
 

1. Totals are automatic inserted with the PivotTable method. 

2. Total column and row labels are automatically inserted with the PivotTable method. 

3. AutoFilter buttons are automatic inserted with the PivotTable method. 

4. If the source data changes, such as inserting a new row in Dept A, simply click refresh to update. 

5. The resulting PivotTable is drillable. 

6. The resulting PivotTable can be pivoted. 

7. The PivotTable report offers many PivotTable tools such as PivotTable formatting which Data 
Consolidate does not offer. 

 

Download these Consolidation example templates at: 

www.CarltonCollins.com/consolidatesimilarbudgets.xlsx 

www.CarltonCollins.com/consolidatedissimilarbudgets.xlsx 
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Benford’s Law  
 
Benford’s Law predicts the occurrence of digits in large sets of data. Simply put, this law maintains 
that we can expect some digits to occur more often than others. For example, the numeral 1 
should occur as the first digit in any multiple-digit number about 30.1% of the time, while the 
numeral 9 should occur as the first digit only 4.6% of the time. We also can apply the law to 
determine the expected occurrence of the second digit of a number, the first two digits of a 
number and other combinations.  
 
How can such predictions help you red-flag potential irregularities? When someone creates false 
transactions or commits a data-entry error, the resulting numbers often deviate from the law’s 
expectations. This is true when someone creates random numbers or intentionally keeps certain 
transactions below required authorization levels.  
 
For example, in 2008, Bernie Madoff famously created fictitious data to hide an 
estimated $65 billion in losses resulting from Madoff’s investment Ponzi scheme.  
– Had the CPAs looked at this data using Benford’s Law, they might have found that 
the digits smelled of fraud, perhaps triggering a deeper investigation. 
 

Applying Benford’s Law Using Excel 
 
According to Benford’s Law, the various digits should occur as the first digit position according to 
the following percentages.  
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To analyze data, simply use the LEFT function to extract the leading digits, and then add them up 
as follows. As a simple example, I found a random workbook containing 136 rows of revenue 
amounts. I entered a formula in cell C4 to extract the first digit and copied this formula down. 
Next I used the COUNTIF function to count the number of occurrences of each of the nine digits, 
and calculated their rate of occurrence, then charted the results.  
 

 
 
 
 
 
You can clearly see that this data pattern does not conform to Benford’s law, and yes, I fabricated 
this particular set of data years ago.  
 
When Excel helps you spot a deviation like this, it raises a red flag. Considerable statistical 
research supports the effectiveness of Benford’s Law, making it a valuable tool for CPAs. The 
technique isn’t guaranteed to detect fraud in all situations but is useful in analyzing the credibility 
of accounting records.  
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A Note of Caution  
 
Benford’s Law is not effective for all financial data. If the data set is small, the law becomes less 
accurate because there are not enough items in the sample and so the rules of randomness don’t 
apply—or at least apply with less predictability.  
 
Also, if the data include built-in minimums and maximums, they also might not conform well to 
the law’s predictions. For example, consider a petty-cash fund where all disbursements are 
between a $10 minimum and a $20 maximum. All first digits would be either 1 or 2, and the 
expected distribution of first digits would not apply. Likewise, when a company’s major product 
sells for, say, $9.95, most sales totals will be a multiple of 995, again offsetting the value of the 
process. Finally, when a data set consists of assigned numbers, such as a series of internally 
generated invoice numbers, the data will not follow a Benford distribution.  
 

History of Beford’s Law  
 
Newcomb, 1881 - The discovery of Benford's law dates back to 1881, when the American 
astronomer Simon Newcomb noticed that in logarithm tables (used at that time to perform 
calculations) the earlier pages (which contained numbers that started with 1) were much more 
worn than the other pages. Newcomb's published result is the first known instance of this 
observation and includes a distribution on the second digit, as well. Newcomb proposed a law 
that the probability of a single number N being the first digit of a number was equal to log(N + 1) 
− log(N). 
 
Benford, 1938 - The phenomenon was again noted in 1938 by the physicist Frank Benford, who 
tested it on data from 20 different domains and was credited for it. His data set included the 
surface areas of 335 rivers, the sizes of 3259 US populations, 104 physical constants, 1800 
molecular weights, 5000 entries from a mathematical handbook, 308 numbers contained in an 
issue of Readers' Digest, the street addresses of the first 342 persons listed in American Men of 
Science and 418 death rates. The total number of observations used in the paper was 20,229. 
This discovery was later named after Benford. 
 
Varian, 1972 -  In 1972, Hal Varian suggested that the law could be used to detect possible fraud 
in lists of socio-economic data submitted in support of public planning decisions. Based on the 
plausible assumption that people who make up figures tend to distribute their digits fairly 
uniformly, a simple comparison of first-digit frequency distribution from the data with the 
expected distribution according to Benford's law ought to show up any anomalous results.  
 
Nigrini, 1999 - Following this idea, Mark Nigrini showed that Benford's law could be used in 
forensic accounting and auditing as an indicator of accounting and expenses fraud. In practice, 
applications of Benford's law for fraud detection routinely use more than the first digit. 
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Analyzing All Digits 
 
Building on the simple example described above, we can expand our Excel formulas to analyze 
all of the digits included in a set of data as follows: In the example shown below, I have used the 
MID function to extract each digit from the column of values in column A, and the resulting 
individual numerals are displayed in columns C through H. Next, I totaled the occurrence for each 
number 1 through 9 in the summary box and charted the results.   
 

 
 
In this example, the data does appear to ever so slightly adhere to Benford’s Law as the first 4 
bars in the chart and a few others seem to come close to matching Benford’s declining curve.  
 
According to Benford’s Law one would expect lower numerals to appear more frequently than 
higher values, but why? Lower digits (1, 2,& 3) tend to appear more frequently than higher digits 
(7, 8, & 9) because it is easier to own 1 acre than 9 acres; and more people have $100 than $900. 
Lower numbers are typically more achievable than higher numbers in many situations. For this 
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reason, we would expect to see an analysis of numbers form a slightly curved declining chart like 
this one: 
 

 
 
However, the presence of the leading digit may significantly skew the data, therefore, we could 
ignore the leading digit and analyze the occurrence of the remaining 8 numerals in an effort to 
determine whether or not the data appears to roughly follow Benford’s Law. Ignoring the leading 
digit reveals the following analysis.  
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As expected, the numeral 1 occurs less often than when the leading digits were included. Still, 
with the leading digit ignored, the data appears not to follow Benford’s Law. 
 

 
 
 

Conclusion 
 
This case study was intentionally brief and is only intended to convey the general ideas related 
to Benford’s law. The forensic CPA may choose to run these numbers to help confirm suspicions 
or beliefs related to the authenticity of a large data set of numbers in question. There are 
probably many instances where this approach would offer little value, however in a high ticket 
audit with high potential for fraud, running Benford’s Law analysis is a rather quick exercise which 
may offer insights to help the forensic CPA determine how to best proceed.  
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Using Regression to Create Budgets &  
Using Budgets to Detect and Prevent Fraud 
 
Excel provides the ability to extrapolate data from your accounting system to produce budgets, 
projections or forecasts using the least squares method of linear regression. The process is 
extremely easy as illustrated in the following example. 
 

A Quick Example:  
 
In this example I have exported the income statements for the past six years from my QuickBooks 
accounting system. The next step is to highlight these five columns (from 2009 through 2013 as 
shown below), and drag the Fill Handle to project 2014 beginning budget values. (Please note 
that in this example I have selected the entire columns and the Fill Handle is shown in the upper 
right hand corner of the selected range.) 
 

 
Using the Fill Handle to Create a Budget for 2014 based on Five Years of Actual Data 

 

Why Does This Work?  
 
But why does this work? How can a simple drag of a mouse create a sophisticated budget? To 
better understand the underlying workings of this concept, let’s start with a more simplified 
example using simple regression. 
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Simple Regression Example: 
 
In the screen below we start with three columns of data for the months of January, February and 
March.  

 
Start with Three Simple Columns of Data 

 
Simply highlight the three columns and drag the Fill Handle out an additional three columns. The 
result is that Excel fills in new columns for April, May and June – including column headings, 
column totals and forecast data, as pictured below.  

 

 
The Fill Handle Uses Regression to Project April, May and June 

 

Explaining Regression: 
 
So where does this new data come from? The answer is that Excel uses linear regression to 
produce this data.  Excel evaluates the data for January, February, and March on a row by row 
basis, and uses this information to project the subsequent variables. To help you better 
understand this concept, here is how regression works from a visual perspective:  
 

1. Once again, a simple example using Excel’s Fill handle. The 8 month’s of data yields a projected 
value of 5,967. 
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2. This time we use the same data, but instead of using the Fill handle, we use the SLOPE and 
INTERCEPT functions to solve for month 9’s projected value. 
 

 
 
As you can see above, the slope and intercept functions produce the exact same result as does 
dragging the Fill Handle, thus proving that the math used by Excel is accurate. 
 

Yet another way to produce the same results is to use the FORECAST function, as follows: 
 

 
 

As you can see in this above example, the FORECAST function also produces the same result as 
the Fill Handle and the SLOPE & INTERCEPT calculations. 

 

All three of these forecast calculations, which produce the same identical values, can be viewed 
visually by creating a Scatter Chart, and then applying a Trendline, as follows: 
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The dotted trend line above is based on linear regression as described in the preceding 
paragraphs. To forecast future values, Excel simply extends this trend line, and then uses the 
intervals of the original data to plot future values, as suggested by the red dotted arrows below. 

 

 
 

Now watch what happens when we base the trendline on logarithmic regression instead of linear 
regression. In the chart below, we see that the trendline is now curving slightly.  

 

 
 

Non-Linear Regression: 
 

Excel provides 5 forms of non-linear regression (as shown in the Trendline Options box in the 
image above) – Exponential, Logarithmic, Polynomial, Power and Moving Average. Collectively, 
these 5 Trendline options are based on different forms of non-linear regression, which is 
explained in detail on this Wikipedia page http://en.wikipedia.org/wiki/Nonlinear_regression. 
The Wikipedia’s explanation is very complicated, but to simplify: non-linear calculations weight 
the data points differently based on their position on the trendline (with linear regression all data 
points are weighted the same). Some mathematicians and CPAs maintain that non-linear 
methods produce more accurate results as more recent data points tend to be more relevant to 
producing a trend than older data points. 
 
You can calculate forecast values in Excel using the Exponential form of regression by using the 
GROWTH function, as follows. 
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Notice that the projected value for month 9 is 5,995.86 using Exponential regression, which in 
this example which is 29.22 higher than the projected value based on linear regression. 
 
The simplest way to forecast values using Exponential regression is to drag the Fill Handle while 
holding down the right mouse button, then selecting Growth from the popup menu as pictured 
below. 
 

 
 

This action will fill in the 9th month with a forecast value based on exponential regression instead 
of linear regression. 
 

LINEST and TREND Functions 
 
Although not used in this case study, you should be aware that Excel provides two additional 
forecasting functions - LINEST and TREND. These functions basically forecast values using linear 
regression exactly like the FORECAST function. The FORECAST and TREND functions are simpler 
to use than LINEST, but the advantage of the LINEST function is that it can also be used as an 
Array function to fill in values for a large range of data. Presented below is a simple example of 
the LINEST function. 
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Data Analysis ToolPak 
 
To use the LINEST function most efficiently, you should first load Excel’s Analysis ToolPak, as 
follows. From the File tab, select Options, Add-Ins. In the Manage box, select Excel Add-ins, then 
click Go. In the Add-Ins dialog box, select the Analysis ToolPak check box, and then click OK. The 
Data Analysis ToolPak will then appear in your Data Ribbon.  
 

 
 
The Data Analysis ToolPak’s Regression analysis tool uses the LINEST function to perform more 
complicated regression analysis which includes controlling the confidence levels and calculating 
and plotting residuals. The screenshot below shows an example of the Analysis ToolPak’s 
Regression tool along (shown in the dialog box) and an example of the output generated by this 
tool beginning in column H. As you can see the output is very complicated, but the resulting 
output can then be used to fine tune various regression calculations.  
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Closer inspection of the ToolPak’s regression tool reveals options for setting the Constant to 
Zero, adjusting the Confidence Level, and utilizing a combination of Residuals, Standardized 
Residuals, Residual Plots, Line Fit Plots, and Normal Probability Plots.  
 

 
 
These detailed aspects of regression are beyond the scope for our particular budgeting purposes, 
but following are links for those that wish to delve further: 
 

1. The 2002 report Using Dummy Variables in Regression by Hun Myoung Park of Indiana 
University (www.iuj.ac.jp/faculty/kucc625/documents/dummy.pdf is a good place to 
start for educating yourself about these variables. 
 

2. This Wikipedia page titled Errors and residuals in statistics goes further in depth into 
residuals. (http://en.wikipedia.org/wiki/Errors_and_residuals_in_statistics) 
 

3. A 6-page Duke University report walking you through an example for using the Data 
Analysis ToolPak’s Regression tool is available here (http://tinyurl.com/cueqap2). 

 

Shortcomings with the Data Analysis ToolPak’s Regression Tool: 
 
To be fair, I should point out that Excel’s ToolPak Regression tool has a number of shortcomings, 
including: 
 

1. Missing Functionality – Other regression tools offer hierarchical regression and case weighting, 
but Excel’s tool does not.  
 

2. Inadequate Diagnostic Charts - Several common diagnostic charts are not included in Excel (for 
example, scatterplot charts, residuals against predicted values, and normality plot of the 
residuals.) Charting typically goes hand-in-hand with forecasting to help visualize the results. 

   
3. No Standardized Coefficients – Without a standardized coefficient, it may be difficult to interpret 

your results.   
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4. Inadequate Diagnostic Statistics – The lack of collinearity diagnostics makes it more difficult to 

understand the forecast data model, although Excel’s PEARSON, RSQAURE and SKEW functions 
could be used to aide in understanding.  

 
Regression Warning  
 
Regression only works when the underlying data follows a consistent trend. If revenue has grown 
steadily for the past six years, then regression will likely project a reasonable value for year seven. 
However if revenue has jumped all over the board for the past six years, then regression will likely 
give you a worthless projection for year seven.  
 

For example, consider that in the past five years gasoline prices jumped from $1.60 per 
gallon to more than $4.00 per gallon. If you use regression to predict gasoline prices for 
future years based on this prior increase, regression will likely predict gasoline prices in 
the $10.00+ per gallon range – but let’s hope that such a prediction would be inaccurate 
– right?  

 

Testing Data’s Suitability for Regression Calculations 
 
Therefore, you should always visit each line item in the projection and consider whether the 
projected values make sense. Excel provides at least two good functions to help you accomplish 
this task – PEARSON and RSQUARE.  For example, in the screen shot below, I have calculated the 
suitability of 5 different sets of data for regression, using both the PEARSON and R SQUARE 
functions.  The first data set on row three has a perfect trend and scores a 100% in both the 
PEARSON and R SQUARE calculations. However, the data sets that follow are comprised of an 
increasingly less perfect trend, and the declining PEARSON and R SQUARE scores reflect this 
decline. 
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For example, I might conclude that the first four sets of data were found to have a sufficient trend 
as to provide a suitable basis for regression calculations but that the data set in row 15 does not. 
You should establish your threshold and consistently stick to that threshold. In this case, I might 
require a minimum 80% PEARSON score and 65% R Square score in order to justify reliance on 
that data as a basis for regression forecasting.  
 

Two More Statistical Measures 
 
Two other Excel functions that might also be useful for analyzing the suitability of data for 
regression include KURTOSIS and SKEW, which both measure the symmetry of data along a bell 
curve. For example, data that is perfectly symmetrical will yield a SKEW score of 0 (zero). The 
closer a data’s SKEW is to zero, the less suitable that data is for regression, because the data’s 
trend is considered unreliable, be it trending upwards or downwards. The KURTOSIS works 
similarly, although it’s scoring is different as it is designed to measure multiple peaks, whereas 
the SKEW measures a single Peak. 
 

Alternatives To Regression 
 
If data is found to be inadequate for regression calculations, then other forecasting methods will 
be necessary. For example, you might: 
 

1. Inflation Forecasting - Forecast future amounts based on prior year amounts inflated for inflation, 
increases in the consumer price index, or some other inflation factor. 
 

2. Percentage Forecasting - Forecast future amounts as a percentage of another line item, such as 
sales or payroll. For example, Cost of Goods Sold (COGS) might be forecast as 45% of forecast 
Sales since historically, COGS does approximate that percentage amount. Or you might forecast 
Fringe Benefits as 15% of Payroll since historically, Fringe Benefits do approximate that 
percentage amount. 
 

3. Best Guess Forecasting - You might come up with another forecast amount based on discussions 
with department heads. For example, the training budget might be forecast  much higher than 
regression, inflation, or percentage methods because you know that since the new version of 
Windows 8 and Office 2013 will be implemented, a significantly higher than normal amount of  
training will be needed to bring everyone up to speed on those products. 

   

Always Use Your Better Numbers When You Have Them 
 
(This should be obvious to all, but I will say it anyway…) Of course some budget line items should 
never be forecast using regression or other forecasting methods because they are known 
amounts. For example, regression may suggest that rent expense might be $236,433.12 for 
January 2014, but since I have signed a lease agreement, I know that rent expense will be exactly  
$220,000 for January 2014, so that is the amount I will use. The same goes for known line items 
such as depreciation expense, web-hosting expenses, interest payments on outstanding loans, 
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and any other contractually known obligations. You would always use these more accurate 
numbers instead of regression’s projected numbers. 
 

Critical Key Point to Understand 
 
The key point is that regression represents a starting point for many of the budget line items, but 
not all budget line items. In all probability, a combination of forecasting methods will need to be 
applied depending on each particular line item – regression should not be relied upon for all 
forecast data.   
 

Detailed Budget Example Using Regression 
 
Starting with Dynamics GP 
 
Now that we’ve discussed the various concepts related to regression, you are now ready to see 
it in action. In this example, we will start by exporting 4 years’ worth of income statement data 
from Dynamics GP to Microsoft Excel (virtually every accounting system on the planet enables 
users to complete this step). In Dynamics GP, we start by printing a 36-month income statement 
to the screen (as pictured below) and exporting it to Excel. 
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Next in Excel, Regression Creates the Initial Budget  
 
Once in Excel, to create the initial budget, select the 36 columns with numeric data, then left click 
and drag the “Fill Handle” out twelve additional columns to create the 2014 budget, as suggested 
below. 
 

  
 

The result is that Excel uses linear regression analysis to predict the future values. Keep in mind 
that this is just an initial starting point.  
 

Overwrite those line items where you have better numbers 
 
Once we have completed this process, we then insert better numbers on those line items where 
we have better budget amounts. For example, the current lease agreement will provide the most 
accurate amount to use for rent expense. We would use our depreciation schedule to provide 
the most accurate amounts for depreciation expense. For interest expense, we would look to the 
loan amortization schedule to prove these numbers (and so on). However for those numbers 
where you have no better basis to use for budget preparation purposes, why not use linear 
regression analysis to provide the answer? 
 
To accomplish this task, it is best to use the split screen tool to split the screen into four areas so 
you can easily see the row descriptions and column headings for the corresponding budget line 
items you are working with. (Excel 2013 no longer provides split screen tools on the scroll bars 
as did Excel 2003, 2007 and 2010 – you must click the Split Screen tool icon on the View tab and 
then adjust the splits by dragging them). Now scroll each line item and ask yourself if you have a 
more accurate basis for forecasting that line item, and if so, insert those more accurate values. 
For example, I have inserted new depreciation values (highlighted in grey) in the screenshot 
below. 
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Document Your Budget Values 
 
For each line item you change, you should document the basis for that budget line item with an 
Excel comment, (or some other method such as an adjacent in-cell comment). For example, in 
the screenshot below, I have inserted Comments next to each account description indicating the 
line item’s forecasting basis. Comments are indicated by small red triangles in the upper right 
corner of a cell and the comment is displayed whenever you hover over the red tick mark with 
your mouse. 
 

 
 

To print comments, select Page Setup from the Page Layout tab, and on the Sheet tab select At 
end of the sheet from the Comments dropdown box, as pictured on the left below. Note that 
the comments do not show up in Print Preview, but they do appear as a printed page at the end 
of your print out; an example of which is pictured on the right below.  
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Testing Data for Regression Suitability 
 
Next we will test each line item’s data for regression suitability. This step will help us determine 
which rows, if any, need to be forecast using a method other than regression. We start this 
process by labeling a couple of blank columns Pearson and R Square, then enter the respective 
formulas to test the 36 columns of data row–by–row, as shown below, on the left. 
 

 
 
Notice that both the PEARSON and R SQUARE 
formulas return percentage values that are both 
negative and positive, which means the data is 
trending upward or downward. Since we don’t care 
which direction the data is trending, (we only care 
that it scores high), we can edit the formulas to 
include the ABSOLUTE function (ABS) which 
changes all amounts to positive numbers, as 
picture above on the right. 
 
Now we can set our thresholds to minimum scores, 
let’s say 50% (Pearson) and 40% (R Square) for 
example, then apply conditional formatting to flush 
out those line items that meet our stated criteria. 
As pictured to the right, those line items in columns 
BB and BC containing formatting are not suitable 
for regression based on our stated criterion level, 
and another forecasting method will need to be 
used to forecast those amounts. For example, we 
may simply use last year’s number inflated by the 
consumer price index. 
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Budget Totals 
 
Now that we have generated regression amounts, and overwritten those amounts where we 
have more accurate numbers and also those where regression is not suitable, we continue by 
totaling the 12 months to produce the annual 2014 budget amounts, as pictured below. 
 

 
 

The purpose of totaling the annual budget is so we can adjust the monthly budget for seasonality, 
as discussed below. 
 

Adjusting for Seasonality 
 
Annual budget amounts are not very useful because they do not allow you to compare actual to 
budgeted results on a monthly basis – you must produce monthly budget amounts. However, 
simply dividing an annual budget by 12 to produce monthly amounts is not good enough because 
many line items are typically seasonal.  For example, actual revenue may be twice as high in some 
months compared to other months, but comparing these seasonal sales amounts to a non-
seasonal budget is virtually meaningless because you can’t tell whether you are on target, off 
target, or by how much. Therefore, it is difficult to determine whether corrective measures are 
needed on a month to month basis. 
 
Seasonal budgets make a big difference. I believe one of the primary reasons companies fail to 
properly analyze their budgets to actuals throughout the year is because their budgets are not 
seasonal to begin with, and therefore such comparisons are virtually meaningless.  
 
To add seasonality to your budget; simply spread the annual amount of each budget line item 
across the 12 months based on the ratio of last’s year’s monthly amounts compared to last year’s 
annual amount, as follows. 
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Start by creating column headings for the seasonal budget, as pictured below. 
 

  
 
Next, enter a formula using last year’s January value (as of January 2013) as a the numerator and 
the SUM of all of 2013’s values as the denominator, and then multiplied times the 2014 annual 
budget amount (=AD6/SUM($AD6:$AO6)*$BB6), as pictured below. 
 

 
 

Notice in this formula I have used dollar signs to anchor the column references so that I may copy 
the formula down and across to complete the seasonality adjustments. 
 

 
 
 

Rounding & Formatting 
 
It is rather senseless to produce budgets with pennies, or even dollars; I recommend rounding 
the results by editing the seasonality formula. Edit the seasonality formula adding the ROUND 
function in front of the formula and “-2” to the end of the formula to round to the nearest 
hundredths, as pictured. 
 

 
 
Now recopy this revised formula (overwriting the previous seasonally adjusted budget data) to 
update the budget. 
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Finally, select a formatted column (such as column BA in this example) and click the Format 
Painter tool; then highlight the twelve months budget to apply the formatting, as suggested 
below. 
 

 
 
 

This Income Statement Budget Is Not Yet Completed 
 
At this point, we have prepared a complete monthly budget using regression supplemented with 
other forecasting methods, and this effort may be sufficient for your needs. However, please be 
aware that this budget example was simplified in order to more easily convey Excel’s regression 
tools and concepts. There is more to the process for those truly dedicated to creating the most 
accurate budget possible – keep reading.  
 

Forecasting Revenue 
 
In the example above, for the purpose of explaining regression as simply as possible, I treated 
the budgeting process for revenue exactly the same as the budgeting process for expenses, but 
in reality budgeting revenue is usually a different process from budgeting expenses.  
 
For established companies, many projected expenses can be reasonably determined using 
regression, inflation, percentage of sales or best guess forecasting methods. However, revenue 
is subject to far greater external factors such as competition, marketing, the state of the 
economy, inflationary pressures, changing attitudes, etc. For example, the appearance of a new 
competitor in the marketplace could steal away market share and thus negatively impact 
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revenue. For example, in late 2012 Apple shares fell from $700 a share to almost $400 a share 
for no other reason than the prospects that Microsoft’s, Google’s and Samsung’s new tablet PC 
offerings were expected to eat into Apple’s market share.  
 
Negative press related to the quality of your product (such as the gas pedal sticking for Toyotas) 
could adversely affect sales. By contrast, your product may become wildly popular if a well know 
celebrity starts wearing or using your product. A good marketing campaign can help significantly, 
or hurt if it happens to make the wrong impression.  
 
The point is that regression is unable to incorporate factors like this, therefore a more detailed 
forecasting approach is usually needed. A good budget will consider all of the relevant factors 
and in the end, you may produce multiple budgets given differing anticipated scenarios. 
 

Simple Example of Revenue Projection Based on Units 
 
In the following example, Crazy Fred’s has listed the number of training courses scheduled for 
each month of the budget year, and has projected attendance for each month based on the 
average attendance achieved in previous years for those same months. Crazy Fred charges a 
course fee of $100 per attendee, which is input in cell A8. Crazy Fred also knows that the fixed 
cost of printing the training manual and having the food catered will be $22 and $27, respectively 
– as input into cells A11 and A12. 
 

     
 
Notice that this projection method does is not based on historical revenue amounts, only 
historical attendance figures have been used. In this example, the company knows how many 
classroom venues have been booked and has a fairly decent idea as to what attendance might 
be; therefore, regression based on historical revenue amounts would not be as accurate as using 
these known quantities to forecast revenues.  
 
A more sophisticated example of forecasting revenues based on units of production is shown 
below. In this example, a CPA firm has listed each employee along with each employee’s 
budgeted billable hours and billing rates by month.  
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In this example, projected revenue is again based upon units rather than historical revenue 
amounts, as regression methods applied to historical revenue amounts would likely yield less 
accurate projections. 
 
Keep in mind that revenue is often more volatile than expenses. An effective marketing program 
might increase the number of units sold, a bad economy might adversely affect the number of 
units sold. Any foreseen or expected events like these should be incorporated into the budget 
and explained in detail.   
 
In conclusion, while the regression example above was used to forecast both revenue and 
expenses, in many cases regression should probably only be used as a means of forecasting 
expenses only.  
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Budgeting Balance Sheets and Cash Flow 
 
In many cases, budgets consist of a profit and loss statement only, but I believe this falls short.  
 
By creating a budgeted balance sheet and cash flow statement, (which requires the creation of a 
budgeted balance sheet), a company can truly monitor expected results for every account, 
including the all-important cash flow balance. The process starts by forecasting the balance sheet 
and once created, forecasting cash flow is a simple matter of crunching the numbers.  
 
To produce a budgeted balance sheet, assumptions are needed related to the days in accounts 
receivable, accounts payable and inventory. These day calculations are best derived by examining 
the historical days in accounts receivable, accounts payable and inventory for recent years, and 
using those amounts as a guide. For example: 
 

1. AR - The budgeted accounts receivable balance may be calculated as 46 days of the prior month’s 
sales. 
  

2. AP - The budgeted accounts payable balance may be calculated as 28 days of the prior month’s 
variable expenses. 
 

3. Inventory - The budgeted inventory balance may be calculated as 62 days of the prior month’s 
COGS amount. 
 

4. Loan Payments – Loan repayments should be budgeted based on the actual amortization 
schedules, based on the principle payment amounts.  
 

5. And so on. 
 
Once the balance sheet items have been budgeted, the resulting cash flow budget is computed 
as follows: 
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The area in yellow (rows 5 through 19) shows the profit and loss budget as projected using the 
methods described earlier above. The blue area (rows 21 through 25) depicts the assumptions 
and the changes in balance sheet balances. The green areas (rows 26 through 32) represent the 
forecast balance sheets and cash flow forecast. Because the income statement is seasonalized, 
the balance sheet balances and cash flow forecast will also be seasonalized.  
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Profit Margin Monitoring & 
Calculating Your Desired Profit Margin  
 
It is also useful for companies to budget and monitor their profit margins; a profit margin that 
misses its target speaks volumes. Once established, budget to actual profit margin comparisons 
can also be used as benchmarks to help detect fraud, errors or irregularities.  To calculate your 
desired profit margin, I suggest that you work backwards by asking yourself (or your client) two 
simple questions, for example: Let’s assume that Burt has owned and operated a construction 
company store for the past 17 years. As his CPA, I ask him two questions as follows: How much 
profit do you want to make next year and how much sales do you anticipate next year?  
 

Burt responds – “that’s easy, we’ve been growing at 8% a year for the past five 
years and last year (2013) we nearly reached $12 million sales, so we will probably 
hit $13 million in revenue next year (2014). Also, I’d like to make a million dollars 
profit – I think that’s a reasonable goal.”  

 
With just this little bit of data, we can work backwards based on Burt’s prior year financial 
statements and advise him as follows:  
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Burt’s fixed costs are a little more than $6 million in 2012, but let’s say that we can adjust 
this amount down to $5,200,000 because the company was able to renegotiate and sign 
a new lease agreement. The point is that we are using 2012’s fixed cost amount along 
with any known adjustments. This allows us to work backwards to calculate the projected 
Gross Margin of $6,200,000. 
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From here we can compute Cost of Goods Sold, and then divide Cost of Goods Sold and 
Gross Margin by Sales to derive the desired Profit Margin that will cover Fixed Costs, 
Variable Costs and still have the desired Net Income of $1,000,000 left over.  In 
conclusion, a Profit Margin of 47.7%will yield the desired results.  
 

 
 

Now that the optimum profit margin is known, let’s say that further analysis reveals that 
the inventory and labor items on average are priced at just 44.5% above cost, as the 
following calculations show, net income for 2014 would only be expected to reach 
$585,000 – well below Burt’s desired profit. 
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At this point, you need to convince Burt of the importance of pricing his products and 
services at the desired profit margin in an effort to target the desired results. To convey 
this point, you will tell Burt the following laughable story about the Florida boys who 
started a business in Gainesville, Florida selling onions. It goes like this:  

 
These two Florida boys were running up to Georgia and buying Vidalia onions at 4 for 
$1.00 which they then took back to Gainesville and sold for a quarter a piece on the 
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streets. The business was an instant success and soon those boys found themselves selling 
from a road side stand, to a small store, to a much bigger store. The customers kept 
coming and the business kept getting bigger. Soon they had customers lined up around 
the block to buy those onions, which they kept buying 4 for a dollar and selling for 25 
cents apiece.  
 
After six months, one Florida boy turned to the other and said – “you know, business is 
great! But I don’t think we’re making any money – what do you think we should do?” The 
other Florida boy thought real hard and then blurted – “I think we need a bigger truck.” 
  

OK, it’s an old exaggerated story, but there is a lesson to be learned here. If you don’t price your 
products to make a profit, you will never make a profit. And, if you don’t price your products to 
make your desired profit, you will never make your desired profits. In our example above, Burt 
should consider setting his margin pricing to target a profit margin of 47.7%, instead of the 
current profit margin of 44.5% to ensure a chance of achieving his desired goals. Without this 
measure, Burt has absolutely no chance of reaching his goals, unless his revenue estimate is 
wildly under-stated.  
 
To be sure, if Burt’s costs go up or down, his prices will need to be adjusted accordingly to provide 
the desired profit margin. But when you think about it, this approach is one in which Burt sells 
his goods and services to his customers at the lowest price point possible that covers his fixed 
costs, variable costs, and desired profit – and not a penny more. It seems reasonable that every 
company in the world strive for this goal - right? 
 
Here’s a simplified way to look at this - suppose your business was to purchase candy bars for 
resell. Your only options are to sell the candy bars for: 
 

A. Below cost. 
B. At cost. 
C. At cost plus your desired profit. 
D. At cost plus an egregiously high profit. 
E. At cost plus some random profit that may or may not be sufficient. 

 
I can’t see how any reasonable person could select any option other then C – yet I see many 
companies sell their products based on all of these scenarios because they don’t take time to 
calculate their desired profit margin, and then monitor that amount throughout the year.  
 
You can download this Profit margin template at www.CarltonCollins.com/profitmargin.xlxs. 
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Data Analysis Tools 
 
Preparing Data for Data Analysis 
 
Before you start to analyze data using Excel’s various data commands such as Sort, Autofilter, 
Subtotal, Grouping, Consolidate, or PivotTable, you should first inspect your data to determine 
if it is in Analysis-Ready condition. In general, this means that the data must meet the following 
criteria: 
 

a. Contiguous Data – The data should contain no blank rows or blank columns. For example, 
the screen below shows blank rows (with solid lines). These rows should first be removed 
before proceeding with the creation of a PivotTable. 
 

 
 

b. Single Row Data – Some accounting systems produce data that spans two or more rows 
per transaction. If this is the case, your will need to clean that data so that all related 
information for a single transaction or data is contained on a single row. For example, the 
following data contains multiple rows of data related to a single sales order. In this case, 
the user must move and paste the data to fall on a single row. This is an example of data 
that requires a great deal of clean up. 
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c. Column Headers -  The data should contain a unique header atop each column. For 
example, the following screen contains two columns labeled Date, while columns D and 
E contain no heading. These are both cases of data that should be cleaned before creating 
a PivotTable.  
 

 
 
If you attempt to analyze data that does not contain a column heading atop all columns, 
you will sometimes receive an error message, such as the example shown below. 
 

 
 
If you have data with the same column heading used more than once, Excel will 
sometimes alter the column headings, for example when you create a PivotTable, so all 
headings will be unique. 
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d. Row Descriptions – Generally, your data should repeat row descriptions for each row. For 
example, the screen below shows that the state and city descriptions are not repeated 
for each row in columns A & B.  
 

 
 
A solutio for quickly filling in the missing row descriptions is presented later in these 
materials. 

 
e. Transposing Headers and Rows – In some cases, data may need to be transposed because 

many of Excel’s Data tools use the column headings, not the row headings to crunch the 
data. To do this, copy the data, then select Paste Special, Transpose, OK to flip the data 
around.   
 

f. Clean Data – The data must be clean of empty text cells containing spaces, special 
characters, extra spaces within data, trailing spaces, trailing zeros, leading zeros, etc.  
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Data Analysis Tools 
 
Excel provides specialized tools for analyzing data and generating financial reports, yet most CPAs 
are unaware of these tools or haven’t tried using them before. Specifically useful are the  
Subtotaling, Grand Totaling, Filtering, Consolidating, Grouping & Outlining, Drilling, OLAP Data 
Cubes, PivotTables, Sparklines, Data Bar Reporting, Conditional Formatting, Charting, Foot 
Notes and End Notes, Formula Auditing Tools, Error Checking, Functions, and Data Analysis 
Tools. 
 
The concepts discussed are intended to directly aide the CPA in summarizing, slicing, dicing and 
analyzing data, and generating related financial reports. 
 
2013 Data Ribbon: 
 

 
 
2013 Insert Ribbon: 
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Data Sort 
 
You would think that every Excel user would already know all about sorting data in Excel, but I am 
frequently surprised to find that many users have missed a few key points related to using this 
tool. I don’t mean to belittle you are talk beneath you, but humor me a copy of paragraphs and 
let’s make sure you are fully up to speed on the following key sorting points: 
 
1. Contiguous Data - The “A to Z” sorting tool can sort a large matrix of data without having to 

highlight the area as long as the data is contiguous; that is to say that your data should contain 
no blank columns, no blank rows, and the columns must all be labeled with a column heading. 
When data is contiguous, all you need to do is place your cursor in a single cell in a given 
column and click the Sort A to Z or Sort Z to A buttons, and Excel will automatically select the 
entire matrix for sorting. Surprisingly many users waste a great deal of time highlighting sort 
ranges prior to sorting, but this step is often unnecessary. 
 

2. A to Z Button - Simply place the cursor in the desired column for sorting, and press the A to Z 
or Z to A button as the case may be. Excel will automatically sort all continuous columns that 
have headings and all contiguous rows from the top row under the heading labels down to the 
last row in the selected column that contains data. (Note - If you accidently select 2 cells 
instead of just one, your results will not be correct.) 

 
3. Sort by 64 Columns - The “Sort” tool was enhanced beginning in Excel 2007 as it now provides 

the ability to sort by up to 64 columns, instead of just 3 columns. Presented below is a dialog 
box which shows this expanded functionality.  
 

 
 

4. Sort Left to Right – Excel has always provided the ability to sort left to right. To do so, select 
the Sort Options box in the Sort dialog box and click the check box labeled Sort Left to Right 
as pictured below. 
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5. Sort by Color – beginning with Excel 2007, you can also sort by font color or by cell color, or 
both. This is handy in many ways. Sometimes CPAs use color to tag or mark certain cells - and 
later find it useful to be able to sort by those markings. In other situations CPAs use conditional 
formatting to apply color to cells using a wide variety of rules; and thereafter they can sort the 
data based on the resulting conditional colors. The two sort-by-color options are pictured 
below. 
 

 
    

To be fair, it was sort of possible to sort by color in Excel 2003. To accomplish this task, you 
needed to use the CELL function in order to identify information about a given cell such as the 
cell color or font color. Thereafter, the results of that function could be used to sort rows – 
which effectively means that you can sort by color in Excel 2003 – but it takes a bit more effort. 
 

6. Sort By Custom List – Another sorting capability in Excel is the ability to sort by Custom List. 
For example, assume a CPA firm has ten partners, and the Managing partner prefers to be 
shown at the top of the list, and the remaining Partners based on seniority. In this case, you 
could create a Custom List in the Excel Options dialog box listing the partners in the desired 
order, and then sort future reports based on that order. 
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To access the Custom List settings: 
 
1. In Excel 2013 & 2010, select File, Options, Advanced, and scroll to the bottom, and then 

select Edit Custom List. 
 

2. In Excel 2007, select File, Options, select Edit Custom List option a few inches down from 
the top. 
 

3. In Excel 2003, select Tools, Options, and click the Custom Lists tab.  
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Filtering Data 
 
AutoFilter allows you to view a subset of your data and when you are done, you can clear the 
filters to once again redisplay all of your data. To use this tool, start with any list of data and turn 
on the AutoFilter tool. Then position your cursor in the column you want to filter and use the 
drop down arrows to apply your filters as suggested in the screen below. 
 

 
 

Once the filters are applied, you will see a subset of your data. For example, the screen presented 
below shows filtered data for only Macon and Savannah properties.  

 

 
 
As filters are applied, a small funnel icon appears in the drop down arrow button to indicate that 
a filter has been applied to that particular column. 
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Key Points Concerning the AutoFilter Command: 
 

1. Contiguous Data – The AutoFilter tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

2. Column Headings –Your columns need unique column headings in and single row, and if 
the column headings are not in row 1, then the row above the column headings should be 
blank so Excel will auto detect the correct range.  
 

3. Filter by Multiple Columns - You can filter by more than one column. 
 

4. Filters are Additive - Each additional filter is based on the current filter and further reduces 
the subset of data. 

 
5. Removing Filters – In all editions of Excel, a fast way to remove multiple filters is to turn 

AutoFilter off and then turn AutoFilter back on. In Excel 2007 and later editions, you can 
also click the Clear button in the Sort & Filter Group as pictured below.  
 

 
 

6. Filter by Color – You can filter based on colors. For example, you can filter by cell color or 
by a list of numbers, you can filter by icon or by a custom filter.  
 

 
 

Note that the Color Filter is mutually exclusive as you cannot also filter by value or text 
when filter by color is applied, and vice versa. 

 

7. Filters Enabled - A drop-down arrow  means that filtering is enabled but not applied. 
 

8. Filter Applied - A Filter button  means that a filter is applied. 
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9. Filter Spanning - The commands 

under the All Dates in the Date 
Filters menu, such as January or 
Quarter 2 filter by the period no 
matter what the year. This can be 
useful, for example, to compare 
sales by a period across several 
years. 
 

10. This Year vs. Year-to-Date - This 
Year and Year-to-Date are 
different in the way that future 
dates are handled. This Year 
filtering can return dates in the 
future for the current year, 
whereas Year-to-Date only 
returns dates up to and including 
the current date based on the 
computer’s time clock. 
 

11. Filtering Dates - All date filters are based on the Gregorian calendar as decreed by Pope 
Gregory XIII, after whom the calendar was named, on 24 February 1582. The Gregorian 
calendar modifies the Julian calendar's regular four-year cycle of leap years as follows: 
Every year that is exactly divisible by four is a leap year, except for years that are exactly 
divisible by 100; the centurial years that are exactly divisible by 400 are still leap years. For 
example, the year 1900 is not a leap year; the year 2000 is a leap year. 

 
12. Filtering By Days of Week - If you want to filter by days of the week, simply format the 

cells to show the day of the week, or 
insert a new column and use the 
WEEKDAY function to calculate the 
week day, and then apply filters using 
this new column. 
 

13. Top & Bottom Filtering - On the Data 
tab, in the Sort & Filter group, click 
Filter. Point to Number Filters and 
then select Top 10. To filter by 
number, click Items. To filter by 
percentage, click Percent. Note - Top 
and bottom values are based on the 
original range of cells or table column 
and not the filtered subset of data. 
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14. Above & Below Average Filtering - On the Data tab, in the Sort & Filter group, click Filter. 
Select Number Filters, Above/Below Average. Note – These values are based on the 
original range of cells or table column and not the filtered subset of data. 
 

15. Filtering Out Blanks - To filter out blanks, in the AutoFilter menu at the bottom of the list 
of values, de-select the check box labeled Blanks. 
 

16. Filtering By Color - Select Filter by Color, and then depending on the type of format, select 
Filter by Cell Color, Filter by Font Color, or Filter by Cell Icon. Note that these filter options 
only show up when there are actual cell colors, font colors or icons included in the data 
range.  
 

17. Filter by Selection - To filter by text, number, date, time, or color for selected cell(s), select 
the cells to be used as a filter basis and then right-click that selection, and from the popup 
menu select Filter, Filter by Selected Cell's Value, (or Filter by Selected Cell's Color, Filter 
by Selected Cell's Font Color, or Filter by Selected Cell's Icon). 
 

 

 
 

18. Refreshing Filters - To reapply a filter after the data changes, click a cell in the range or 
table, and then on the Data tab, in the Sort & Filter group, click Reapply. 
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Data Form 
 
Excel’s Data Form tool provides a data input window which makes Excel look and behave more 
like a database, such as Microsoft Access. (Note that in Excel 2013, 2010 and 2007, the Form tool 
button has not been included on the Ribbon, so to use it you will first need to add the Form tool 
button to the Quick Access Toolbar.)  
 

 
 

A data form provides a convenient means to enter or display one complete row of information 
in a range or table without scrolling horizontally. Some people, especially those who are used to 
using databases, find that using a data form can make data entry easier than moving from column 
to column when you have more columns of data than can be viewed on the screen.  
 
Key Points using Data Form: 
 

1. You cannot print data from a data form. 
  
2. Because a data form is a modal dialog box, you cannot use either the Excel Print command 

or Print button until you close the data form.  
 
3. You might consider using the Windows Print Screen key to make an image of the form, 

and then paste it into Microsoft Word for printing. 
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Data Subtotals 
 
Excel’s Subtotal command automatically calculates and inserts subtotals and grand totals in your 
list or table. Once inserted, Excel recalculates subtotal and grand totals as you enter and edit the 
detail data. The Subtotal command also outlines the list so that you can display and hide the 
detail rows for each subtotal. Examples of the Subtotal dialog box and a resulting subtotaled 
table are shown below. 
 

  
 

 
 

To display subtotals and grand totals at the top instead of the bottom, deselect the checkbox 
labeled Summary below data.  
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Key points to Consider When Using Subtotaling are as follows: 
 

1. Contiguous Data – The Subtotal tools works best when you are working with data that is 
contiguous. In other words, your data should contain no blank columns, no blank rows, 
and the columns must all be labeled.  
 

2. Sort Before You Subtotal - You must sort the data by the column you wish to subtotal by, 
else you will receive erroneous results.  

 
3. Other Mathematical Applications - The Subtotal tool not only calculates subtotals, but it 

can also calculate minimums, maximums, averages, standard deviations, and other 
functions.  

 

 
 

4. Subtotals in 2013, 2010 & 2007 Tables – Excel 2007 added a new Table tool which enables 
Subtotals a little differently; the Subtotal tool appears at the bottom of each column in 
each Table, as shown in the screen below. 
 

 
  

5. Automatic Outlining – The Subtotal tool automatically inserts Outlines, which allows you 
to collapse or expand your data.  
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6. Copying Outline Data - Some CPAs also like to copy and paste collapsed subtotal data to 
another location, but they find this process copies and pastes all of the data – not just the 
summary data they desire. In this situation, there are two ways to achieve a clean copy 
and paste without grabbing all the hidden data as follows: 
 

a. CTRL key – Hold the Control Key down while you individually click to select 
individual rows; this action will enable you to copy and paste selected data. 
However, this approach can sometimes be problematic because if you miss-click, 
you have to start over. 

 
b. Select Visible Cells – A better approach is to use the Select Visible Cells tool. This 

tool will select on the data you can see, after which the copy and paste routine 
will yield the desired results. This option is better because it is faster and less error 
prone.  

 

 
 

c. Go To – You can also select visible cells using Go To. To do this, press F5 to launch 
the Go To tool and then click Special. In the Go To Special dialog box, select the 
radio button labeled Select Visible cells and press OK.    
 

 
 

d. ALT + ; - The Alt + ; key combination is the shortcut to using the Select Visible Cells 
Tool.  
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Data Validation  
 

Data Validation can be used to limit the data that can be entered into a cell. For example, you 
might want the user to enter only values between 1% and 99%. You might also use this tool to 
enable data input to a drop down list which offers two advantages in that it can be faster and 
more accurate.  To create a dropdown list, enter a list into sequentially cells in Excel. Next, from 
the Data tab select Data Validation, Data Validation (yes, again), then in the dialog box (as shown 
below) select List from the Allow dropdown box and then indicate the data range for your list in 
the Source box. 
 

 
 
After making all the necessary selections in the validation list dialog box, your worksheet will 
produce a cell containing a drop down list (shown in cell A10 below) that behaves as shown.  
 

 
 
You can also provide messages to define what input you expect for the cell, and instructions to 
help users correct any errors. For example, on a worksheet, you can set up a cell to allow only 
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account numbers that are exactly three characters long. When users select the cell, you can show 
them a message such as this one: 
 

 
 
If users ignore this message and type invalid data in the cell, such as a two-digit or five-digit 
number, you can display an actual error message. In a more advanced scenario, you might use 
data validation to calculate the maximum allowed value in a cell based on a value elsewhere in 
the workbook. In the following example, the user has typed $4,000 in cell E7, which exceeds the 
maximum limit specified for commissions and bonuses. 
 

 
 
If the payroll budget were to increase or decrease, the allowed maximum in E7 would 
automatically increase or decrease with it. 
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Data Table (“What-if Analysis”)  
 
Data tables are part of the collection of what-if analysis commands, which include:  
 

1. Data Tables 
2. Goal Seek 
3. Scenarios 

 
The Data Table command enables the process of changing values in cells to see how those changes 
will affect the outcome. For example, you can use a data table to vary the interest rate and term 
length used in a loan to determine possible monthly payment amounts.  
 
There are two types of Data Tables – One Way and Two Way. A data table cannot accommodate 
more than two variables. If you want to analyze more than two variables, you should use 
scenarios. Although it is limited to only one or two criterion (one for the row input cell and one 
for the column input cell), each criterion can include as many different variable values as you want. 
(In contrast, a Scenario can have a maximum of 32 different criterion, but you can create as many 
Scenarios as you want.) 
 
Loan Analysis Example  
 
In this exercise, we start by creating a simple Payment function to calculate the payment amount 
of a loan given a loan amount, interest rate and number of periods.  
 

 
 

The next step is to create a Two-Way Data Table displaying the resulting payment amount given 
a variety of lengths of the loan. This process is started by creating a list of the alternative loan 
amounts, as shown below in B8, B9, B10, etc. Cell C7 must reference the results you want to be 
displayed in the table. 
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Next, highlight the data table range and use the Data Table command on the Data tab (as 
shown below) to generate the desired table. 
 

  
 

This process will generate the following table: 
 

 
 
This table tells us that the same loan amount will require a monthly payment of $4,972 to pay 
the loan off in just 6 years, or a monthly payment of $5,800 to repay the loan in just 5 years.  
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The next step in this exercise is to generate a line chart based on the data table we just created. 
This line chart will provide some interesting observations regarding the benefits and detriments 
of paying off loans over longer periods. 
 

 
 

The resulting chart is shown as follows: 
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Based on this, no one should ever obtain a fair market loan for more than 15 years, the reduction 
in payments simply aren’t worth the additional length of the loan. This same basic behavior is 
seen whether the interest rate is 1% or 100%, or whether the loan amount is $1,000 or 
$10,000,000. The only time you might be justified in obtaining a loan longer than 15 years might 
be when you are extended a favorable interest rate (perhaps from a rich uncle), better than a fair 
market interest rate. 
 

Goal Seek 
 
If you know the result that you want from a formula, but are not sure what input values are 
needed to produce your desired results, use Goal Seek. For example, suppose that you have 
decided to purchase a house, but you don’t know how much house you can afford. In this case, 
know how the interest rate (3.75%) and how long you want to take to pay off the loan (15 years), 
and the amount you can afford to pay each month ($2,800). In this case, you can use Goal Seek 
to work backwards to figure out how much house you can afford. Start by calculating the monthly 
payment based on any random home loan amount as pictured below.  
 

 
 

Next, from the Data tab, select What-If Analysis, Goal Seek. Fill in the parameters to set the 
payment amount to $2800 by adjusting the Loan Amount, as shown, and then click OK.  
 

 
 

The result is that a person with $2,800 available to make monthly payments can afford to 
purchase a home costing up to $385,027 (assuming a 15 year loan and 3.75% interest rate) – as 
pictured above. (Keep in mind that anyone actually following this scenario would need to 
consider that homes also come with other monthly obligations including real estate taxes, 
insurance maintenance, etc.)   
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Data - Text to Columns 
 
CPAs sometimes receive data from their clients or IT departments that is in text form. When this 
happens, Excel can split the contents of one or more cells in a column and distribute those 
contents as individual parts across other cells in adjacent columns. For example, the worksheet 
below contains a column of full names and amounts that you want to split into separate columns. 
The Text to Columns wizard parses the data automatically into separate cells. To use this tool, 
select the cell, range or entire column that contains the text values that you want to split.  
 

 
 
 
 
 
Notes:   
 

1. A range that you want to split can include any number of rows, but it can include no more than 
one column.  
 

2. You also should make sure there are enough blank columns to the right of the selected column to 
prevent overwriting existing data in those adjacent columns. 
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Flash Fill  
 
Of all the Office 2013 applications, Excel is the beneficiary of the most impressive enhancements. 
Excel’s new Flash Fill watches you work and applies logic to help you complete your tasks. The 
example pictured below contains a list of 44 first and last names in Column A, which I want to 
separate into Columns B and C. As I start typing the first name of the second record in Column B; 
Excel’s Flash Fill guesses what I’m trying to do and offers to fill in the remaining 42 first names 
(as shown in grey text). 
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Data Grouping & Outlining  
 
If you have a list of data that you want to group and summarize, you can create an outline of up 
to eight levels. Each inner level (represented by a higher number in the outline symbols) displays 
detailed data for the preceding outer level, represented by a lower number in the outline 
symbols. Use an outline to quickly display summary rows or columns, or to reveal the detail data 
for each group. You can create an outline of rows (as shown in the example below), an outline of 
columns, or an outline of both rows and columns. 
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PowerView 
 
Excel’s new PowerView inserts new worksheets connected to your data, and then enables you 
to create new report types, such as the interactive map chart presented below. The resulting 
PowerView Map report is zoomable, and filters can be applied to display partial data. 

 

 
 
PowerView worksheets can be published as standalone, interactive reports to Microsoft 
SharePoint’s PowerPivot Gallery or other reporting service destinations. Some of the tools 
provided by PowerView include the ability to create a dashboard containing multiple 
PowerViews, apply themes and backgrounds, insert pictures and text boxes, insert collapsible 
and expandable tiles, and add data slicers.  
 
PowerView Learning Points 
 

1. Included - PowerView isn’t included in Office Home editions. Power View and PowerPivot are only 
available in the Office Professional Plus and Office 365 Professional Plus editions.  

2. Worksheet - PowerView is another sheet in the workbook, and acts like a Dashboard.  
3. Fields – Add data to the PowerView by selecting fields, much like you do for PivotTables. 
4. Play - You can play charts to see how they change over time. 
5. PowerView uses PowerPivot - Known to be extremely fast for retrieving and sorting data.  
6. Relationships – PowerView can integrate multiple data sets via relationships. 
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Timeline Slicer 
 
CPAs who work with PivotTables will likely appreciate Excel’s new Timeline Slicer which helps 
users slice and dice Pivot data that contain dates. As an example, selecting the dates May through 
October on the Timeline slicer pictured below adjusts the PivotTable to display May thru October 
data.  

 

 
 

 

Quick Analysis 
 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, charts, 
totals, tables and sparkline layouts to instantly summarize large volumes of data (see screen 
below). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
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Queries 
 
Excel 2010, 2007 & 2003 include pre-designed “queries” that can import commonly used data 
such as stock quotes for updating a stock portfolio. All you need is a connection to the internet 
and of course, some stock ticker symbols. In Excel 2010 or 2007 select Data, Existing 
Connections, MSN MoneyCentral Stock Quotes (or in Excel 2003 select Data, Import External 
Data, Import Data Existing Connections, MSN MoneyCentral Stock Quotes) and then walk 
through the web query wizard for importing stock quotes. In just a few seconds, Excel will retrieve 
Real-Time data for NYSE, NASDAQ & AMEX, and 20 minute delayed stock prices from other 
exchanges (during the hours when the stock market is open) and display a grid of complete up-
to-date stock price information that is synchronized to the stock market’s changing stock prices. 
With each click of the “Refresh” button, the stock price information in Excel is updated - this sure 
beats picking numbers out of the newspaper.  
 

 
 
Completing the Stock Portfolio – Next link the grid data to another worksheet, and insert new 
columns containing the number of shares owned, as wells as an additional column to compute 
the total value based on shares owned, as shown below. 
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Refreshing the Stock Prices - Once you have created your portfolio, simply click the Refresh Data 
button on the “External Data” Toolbar in Excel 2003 or on the “Data Ribbon” in Excel 2010 & 
2007 shown below to update the current value of your Portfolio. 
 

 
 
Query Parameters - There are numerous options to help you extract exactly the data you want 
the way you want it. The “Web Query Parameters Box”, “Web Query Options box” and “External 
Data Properties Box” provide numerous options for controlling your web query. 
 
Excel 2013 Stock Quote Queries 
 
In Excel 2013, for unknown reasons Microsoft has removed the stock quote query option, 
therefore below are instructions for restoring this option.  
 

1. Launch Notepad (Start, Programs, Windows Accessories, Notepad) 
 

2. Enter the following information exactly: 
 

 
 

Web 
1 
http://moneycentral.msn.com/investor/external/excel/quotes.asp?SYMBOL=["QUOTE","Ent
er stock, fund or other MSN MoneyCentral Investor symbols separated by commas."] 

 
 

Or if you prefer, use this to query Yahoo’s stock prices:  
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3. Save the file using any name you want, but be sure to include the extension .igy as 
pictured. 

 

 
 

4. Make sure to save this file to the folder labeled My Data Sources. 
 

 
 

5. Now in Excel, from the Data tab select Existing Queries, then scroll to and launch the new 
query you just created – it should work just like it did in Excel 2010, 2007 and 2003. 
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Database Queries  
 
Microsoft Excel can also query and retrieve data you want from an external data source. For 
example, you can retrieve Microsoft Excel data about a specific product by region. You can create 
a simple query by using the Query Wizard, or you can create a more complex query by using the 
advanced features of Microsoft Query. 
 
To use Microsoft Query to retrieve external data, you must: 
 

1. Have access to an external data source - If the data is not on your local computer, you 
may need to see the administrator of the external database for a password, user 
permission, or other information about how to connect to the database. 
 

2. Install Microsoft Query - If Microsoft Query is not available, you might need to install it. 
 

3. Specify a source to retrieve data from, and then start using Microsoft Query -   For 
example, if you want to insert database information, display the Database toolbar, click 
Insert Database, click Get Data, and then click MS Query.  

 
For example, suppose we have some data in our accounting system – Sage MAS 200 ERP that we 
would like to analyze in Excel.  We can use the Database Query Wizard to build a query that will 
extract the data we need and place it in an Excel spreadsheet, as follows. 
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The first step is to select the type of database you want to query and to select the specific 
database. 
 

 
 
Upon the selection of the desired database a list of tables will be presented. Choose the desired 
tables, and select the desired data fields to be imported. You will then have the option to filter 
and sort the data before it is imported.  Finally you will be given the option to save the query so 
you can run it at a later date without having to start from scratch. Excel will then return a table 
full of the data you requested as shown in the screen below. 
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Sparklines 
 

Sparklines – Sparklines are small cell-sized charts that you can embed in a worksheet next to 
data to get a quick visual representation of the data. For example, if you had a worksheet that 
tracked the performance of several dozen stocks, you could create a Sparkline for each stock 
that graphed its performance over time, in a very compact way. Here are examples: 

 
 

Conditional Formatting 
 

1. Conditional Formatting Improvements – Microsoft has improved and added more styles 
and icons regarding the ability to apply a format to a range of cells, and then have the 
formatting change according to the value of the cell or formula.  

 
2. Solid Bars - Data Bars can be solid now in Excel 2010. Excel 2007 bars offered only a 

gradient effect, which was visually was confusing to read. Below is a comparison on the 
Excel 2007 and Excel 2010 Data Bar options.  

 

  
 

3. Negative Numbers - Microsoft corrected a problem which Excel 2007 had when creating 
Data Bars based on negative numbers, by adding axis support for both positive and 

   2007 Gradient           2010 Gradient       2010 Solid 
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negative values. The screens shots below show Excel 2010’s new solution, and how Excel 2007 
got confused when applying Data Bars to the exact same data. 

 

  
 

a. More Data Bar Options - Notice that Microsoft added more Data Bar options as shown 
in the comparison below. 

 
 

 
  

              Excel 2010’s Data Bars               Excel 2007’s Data Bars 

           Excel 2010’s Data Bar Menu            Excel 2007’s Data Bar Menu 
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b. More Icon Options - Notice that Microsoft added more Data Bar options as shown in 
the comparison below. 

 
 
 

c. Arrow Colors - It is possible to change icons used for KPI i.e. You can have two arrows 
with different colors that might represent both a negative impact and positive growth, 
for example. 

 
d. Referring to Data - You can now refer to data on different worksheets, and even refer to 

a range outside the Conditional Formatting area. The screen below shows the error 

              Excel 2010’s Icon Menu         Excel 2007’s Icon Menu 
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message produced by Excel 2007 when you attempted to reference cells outside the 
Conditional Formatting area; Excel 2010 now accommodates this situation. 

 
 

4. Sort by Color – Beginning with 2007, Excel provides the ability to sort by font color or by 
cell color, or both. This is handy in many ways. Sometimes CPAs use color to tag or mark 
certain cells - and later find it useful to be able to sort by those markings. In other situations 
CPAs use conditional formatting to apply color to cells using a wide variety of rules. 
Thereafter Excel can sort the data based on the resulting colors. The sort-by-color options 
are shown below. 

 

 
    

To be accurate, it was possible to sort by color in Excel 2003. To accomplish this task, you 
needed to use the =CELL function in order to identify information about a given cell such as 
the cell color or font color. Thereafter, the results of that function could be used to sort rows 
– which effectively means that you can sort by color in Excel 2003 – but it takes a bit more 
effort. 

  

Excel 2007 
Error 

Message 

http://www.carltoncollins.com/


Excel 2013 for CPAs 

www.CarltonCollins.com Page 90 Copyright May 2013 

 

Excel Functions 
 
An Excel function is a preset formula that calculates a specific result based on the 
criteria/variables/arguments you specify. All functions start with the equal sign followed by the 
function’s name and criteria/variables/arguments you specify. As a simple example, the most 
frequently used function in Excel is the SUM function, which is used to add data.  
 

 
 
There are a total of 455 Excel Functions in Excel 2013; the following table summarizes the number 
of functions introduced in previous editions of Excel. 
 

 
 
 
Excel Functions are preprogrammed formulas that make the task of writing complex formulas 
easier. There are a total of 455 functions in Excel. These functions are separated into 14 
categories as follows: 
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Categories & Number Of Functions In Each Category 
 

1. Compatibility  .................................................................. (38) 

2. Cubes  ................................................................................ (7) 

3. Databases  ....................................................................... (12) 

4. Date and times  ............................................................... (24) 

5. Engineering  .................................................................... (54) 

6. Financials  ........................................................................ (55) 

7. Information  .................................................................... (20) 

8. Logical  .............................................................................. (9) 

9. Lookup and references  .................................................. (19) 

10. Math and trigonometry  ................................................. (79) 

11. Statistical  ...................................................................... (101) 

12. Texts  ............................................................................... (30) 

13. User defined that are installed with add-ins  ................... (4) 

14. Webs  ................................................................................ (3) 

 

Function Relevance to CPAs 
 
Some Excel functions are more powerful than others and some are more relevant to the CPA 
than others. For example, most CPAs will find the IF, SUM, COUNT, SUBTOTAL, TEXT, and 
VLOOKUP are very relevant to the CPA while other engineering and trigonometry functions such 
as LOG, PI, RADIENS, DELTA, TAN, COMPLEX, and HAX2DEC are typically less relevant to CPAs.  It 
has been my experience that approximately 171 functions are more relevant or important to 
CPAs; therefore in my opinion, CPAs wishing to increase their command of Excel functions should 
concentrate on learning these functions primarily. To help you accomplish this goal, presented 
below is a list of all 455 Excel functions, along with a brief explanation of each function. The 170 
functions that I find more relevant are shown in red bold. 
 

Compatibility  
1 BETADIST  Returns the beta cumulative distribution 

2 BETAINV  Returns the inverse of the cumulative distribution for a specified 
beta distribution 

3 BINOMDIST  Returns the individual term binomial distribution probability 

4 CHIDIST  Returns the one-tailed probability of the chi-squared distribution 

5 CHIINV  Returns the inverse of the one-tailed probability of the chi-squared 
distribution 

6 CHITEST  Returns the test for independence 

7 CONFIDENCE  Returns the confidence interval for a population mean 

8 COVAR  Returns covariance, the avg of the products of paired deviations 
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9 CRITBINOM  Returns the smallest value for which the cumulative binomial 
distribution is less than or equal to a criterion value 

10 EXPONDIST  Returns the exponential distribution 

11 FDIST  Returns the F probability distribution 

12 FINV  Returns the inverse of the F probability distribution 

13 FTEST  Returns the result of an F-test 

14 GAMMADIST  Returns the gamma distribution 

15 GAMMAINV  Returns the inverse of the gamma cumulative distribution 

16 HYPGEOMDIST  Returns the hypergeometric distribution 

17 LOGINV  Returns the inverse of the lognormal cumulative distribution 

18 LOGNORMDIST  Returns the cumulative lognormal distribution 

19 MODE  Returns the most common value in a data set 

20 NEGBINOMDIST  Returns the negative binomial distribution 

21 NORMDIST  Returns the normal cumulative distribution 

22 NORMINV  Returns the inverse of the normal cumulative distribution 

23 NORMSDIST  Returns the standard normal cumulative distribution 

24 NORMSINV  Returns the inverse of the standard normal cumulative distribution 

25 PERCENTILE  Returns the k-th percentile of values in a range 

26 PERCENTRANK  Returns the percentage rank of a value in a data set 

27 POISSON  Returns the Poisson distribution 

28 QUARTILE  Returns the quartile of a data set 

29 RANK Returns the rank of a number in a list of numbers 

30 STDEV  Estimates standard deviation based on a sample 

31 STDEVP  Calculates standard deviation based on the entire population 

32 TDIST  Returns the Student's t-distribution 

33 TINV  Returns the inverse of the Student's t-distribution 

34 TTEST  Returns the probability associated with a Student's t-test 

35 VAR  Estimates variance based on a sample 

36 VARP Calculates variance based on the entire population 

37 WEIBULL  Returns the Weibull distribution 

38 ZTEST  Returns the one-tailed probability-value of a z-test 

  

Cubes  

39 CUBEKPIMEMBER  Returns a key performance indicator (KPI) property and displays 
the KPI name in the cell. A KPI is a quantifiable measurement, 
such as monthly gross profit or quarterly employee turnover, that 
is used to monitor an organization's performance. 

40 CUBEMEMBER  Returns a member or tuple from the cube. Use to validate that the 
member or tuple exists in the cube. 
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41 CUBEMEMBERPROPER
TY  

Returns the value of a member property from the cube. Use to 
validate that a member name exists within the cube and to return 
the specified property for this member. 

42 CUBERANKEDMEMBER  Returns the nth, or ranked, member in a set. Use to return one or 
more elements in a set, such as the top 10 sales performers. 

43 CUBESET  Defines a calculated set of members or tuples by sending a set 
expression to the cube on the server, which creates the set, and 
then returns that set to Microsoft Office Excel. 

44 CUBESETCOUNT  Returns the number of items in a set. 

45 CUBEVALUE  Returns an aggregated value from the cube. 

  

Databases  

46 DAVERAGE  Returns the average of selected database entries 

47 DCOUNT  Counts the cells that contain numbers in a database 

48 DCOUNTA  Counts nonblank cells in a database 

49 DGET  Extracts from a database a single record that matches the 
specified criteria 

50 DMAX  Returns the maximum value from selected database entries 

51 DMIN Returns the minimum value from selected database entries 

52 DPRODUCT  Multiplies the values in a particular field of records that match the 
criteria in a database 

53 DSTDEV  Estimates standard deviation based on a sample of the database  

54 DSTDEVP  Calculates the standard deviation based on the entire population 
of selected database entries 

55 DSUM  Adds the numbers in the field column of records in the database 
that match the criteria 

56 DVAR Estimates variance based on a sample of the database  

57 DVARP Calculates variance based on the entire population of selected 
database entries 

   

Date and Time  
58 DATE  Returns the serial number of a particular date 

59 DATEVALUE  Converts a date in the form of text to a serial number 

60 DAY  Converts a serial number to a day of the month 

61 DAYS  Returns the number of days between two dates 

62 DAYS360  Calculates the number of days between two dates based on a 360-
day year 

63 EDATE  Returns the serial number of the date that is the indicated number 
of months before or after the start date 

64 EOMONTH  Returns the serial number of the last day of the month before or 
after a specified number of months 

65 HOUR  Converts a serial number to an hour 
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66 ISOWEEKNUM Returns the number of the ISO week number of the year for a 
given date 

67 MINUTE  Converts a serial number to a minute 

68 MONTH Converts a serial number to a month 

69 NETWORKDAYS  Returns the number of whole workdays between two dates 

70 NETWORKDAYS.INTL  Returns the number of whole workdays between two dates using 
parameters to indicate how many days are weekend days 

71 NOW Returns the serial number of the current date and time 

72 SECOND Converts a serial number to a second 

73 TIME Returns the serial number of a particular time 

74 TIMEVALUE  Converts a time in the form of text to a serial number 

75 TODAY  Returns the serial number of today's date 

76 WEEKDAY  Converts a serial number to a day of the week 

77 WEEKNUM  Converts a serial number to a number representing where the 
week falls numerically with a year 

78 WORKDAY  Returns the serial number of the date before or after a specified 
number of workdays 

79 WORKDAY.INTL Returns the serial number of the date before or after a specified 
number of workdays using parameters to indicate which and how 
many days are weekend days 

80 YEAR  Converts a serial number to a year 

81 YEARFRAC  Returns the year fraction representing the number of whole days 
between start_date and end_date 

   

Engineering  

82 BESSELI  Returns the modified Bessel In(x) 

83 BESSELJ  Returns the Bessel Jn(x) 

84 BESSELK  Returns the modified Bessel Kn(x) 

85 BESSELY  Returns the Bessel Yn(x) 

86 BIN2DEC Converts a binary number to decimal 

87 BIN2HEX  Converts a binary number to hexadecimal 

88 BIN2OCT  Converts a binary number to octal 

89 BITAND Returns a 'Bitwise And' of two numbers 

90 BITLSHIFT  Returns a value number shifted left by shift_amount bits 

91 BITOR  Returns a bitwise OR of 2 numbers 

92 BITRSHIFT  Returns a value number shifted right by shift_amount bits 

93 BITXOR  Returns a bitwise 'Exclusive Or' of two numbers 

94 COMPLEX  Converts real and imaginary coefficients into a complex number 

95 CONVERT  Converts a number from one measurement system to another 

96 DEC2BIN Converts a decimal number to binary 

97 DEC2HEX  Converts a decimal number to hexadecimal 
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98 DEC2OCT  Converts a decimal number to octal 

99 DELTA Tests whether two values are equal 

100 ERF  Returns the error 

101 ERF.PRECISE  Returns the error 

102 ERFC  Returns the complementary error 

103 ERFC.PRECISE  Returns the complementary ERF integrated between x and infinity 

104 GESTEP  Tests whether a number is greater than a threshold value 

105 HEX2BIN  Converts a hexadecimal number to binary 

106 HEX2DEC  Converts a hexadecimal number to decimal 

107 HEX2OCT  Converts a hexadecimal number to octal 

108 IMABS  Returns the absolute value (modulus) of a complex number 

109 IMAGINARY  Returns the imaginary coefficient of a complex number 

110 IMARGUMENT Returns the argument theta, an angle expressed in radians 

111 IMCONJUGATE  Returns the complex conjugate of a complex number 

112 IMCOS  Returns the cosine of a complex number 

113 IMCOSH  Returns the hyperbolic cosine of a complex number 

114 IMCOT  Returns the cotangent of a complex number 

115 IMCSC  Returns the cosecant of a complex number 

116 IMCSCH  Returns the hyperbolic cosecant of a complex number 

117 IMDIV  Returns the quotient of two complex numbers 

118 IMEXP Returns the exponential of a complex number 

119 IMLN  Returns the natural logarithm of a complex number 

120 IMLOG10  Returns the base-10 logarithm of a complex number 

121 IMLOG2  Returns the base-2 logarithm of a complex number 

122 IMPOWER Returns a complex number raised to an integer power 

123 IMPRODUCT  Returns the product of from 2 to 255 complex numbers 

124 IMREAL  Returns the real coefficient of a complex number 

125 IMSEC Returns the secant of a complex number 

126 IMSECH  Returns the hyperbolic secant of a complex number 

127 IMSIN  Returns the sine of a complex number 

128 IMSINH  Returns the hyperbolic sine of a complex number 

129 IMSQRT  Returns the square root of a complex number 

130 IMSUB  Returns the difference between two complex numbers 

131 IMSUM  Returns the sum of complex numbers 

132 IMTAN  Returns the tangent of a complex number 

133 OCT2BIN  Converts an octal number to binary 

134 OCT2DEC Converts an octal number to decimal 

135 OCT2HEX  Converts an octal number to hexadecimal 
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Financial  

136 ACCRINT  Returns accrued interest for a security paying periodic interest 

137 ACCRINTM  Returns accrued interest for a security paying interest at maturity 

138 AMORDEGRC  Returns the depreciation for each accounting period by using a 
depreciation coefficient 

139 AMORLINC  Returns the depreciation for each accounting period 

140 COUPDAYBS  Returns the number of days from the beginning of the coupon 
period to the settlement date 

141 COUPDAYS  Returns the number of days in the coupon period that contains the 
settlement date 

142 COUPDAYSNC  Returns the number of days from the settlement date to the next 
coupon date 

143 COUPNCD  Returns the next coupon date after the settlement date 

144 COUPNUM  Returns the number of coupons payable between the settlement 
date and maturity date 

145 COUPPCD  Returns the previous coupon date before the settlement date 

146 CUMIPMT Returns the cumulative interest paid between two periods 

147 CUMPRINC  Returns cumulative principal paid on a loan between two periods 

148 DB Returns the depreciation of an asset for a specified period by using 
the fixed-declining balance method 

149 DDB  Returns the depreciation of an asset for a specified period by 
using the double-declining balance method or some other 
method that you specify 

150 DISC  Returns the discount rate for a security 

151 DOLLARDE  Converts a dollar price, expressed as a fraction, into a dollar price, 
expressed as a decimal number 

152 DOLLARFR  Converts a dollar price, expressed as a decimal number, into a 
dollar price, expressed as a fraction 

153 DURATION  Returns the annual duration of a security with periodic interest 
payments 

154 EFFECT  Returns the effective annual interest rate 

155 FV  Returns the future value of an investment 

156 FVSCHEDULE  Returns the future value of an initial principal after applying a 
series of compound interest rates 

157 INTRATE  Returns the interest rate for a fully invested security 

158 IPMT Returns interest payment for an investment for a given period 

159 IRR Returns the internal rate of return for a series of cash flows 

160 ISPMT Calculates the interest paid during a specific period of an 
investment 

161 MDURATION  Returns the Macauley modified duration for a security with an 
assumed par value of $100 

162 MIRR  Returns the internal rate of return where positive and negative 
cash flows are financed at different rates 

163 NOMINAL  Returns the annual nominal interest rate 

http://www.carltoncollins.com/
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753127&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753126&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753121&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753119&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753076&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753075&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753074&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753073&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753072&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753071&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753070&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753069&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753061&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753057&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753049&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753045&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753044&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753039&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753034&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753010&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753009&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752970&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752968&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752967&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752963&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752939&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752932&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753459&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955


Excel 2013 for CPAs 

www.CarltonCollins.com Page 97 Copyright May 2013 

 

164 NPER Returns the number of periods for an investment 

165 NPV  Returns the net present value of an investment based on a series 
of periodic cash flows and a discount rate 

166 ODDFPRICE  Returns price per $100 face value of a security with an odd first 
period 

167 ODDFYIELD  Returns the yield of a security with an odd first period 

168 ODDLPRICE  Returns the price per $100 face value of a security with an odd last 
period 

169 ODDLYIELD  Returns the yield of a security with an odd last period 

170 PDURATION  Returns the number of periods required by an investment to reach 
a specified value 

171 PMT  Returns the periodic payment for an annuity 

172 PPMT  Returns the payment on the principal for an investment for a 
given period 

173 PRICE  Returns the price per $100 face value of a security that pays 
periodic interest 

174 PRICEDISC  Returns the price per $100 face value of a discounted security 

175 PRICEMAT  Returns the price per $100 face value of a security that pays 
interest at maturity 

176 PV  Returns the present value of an investment 

177 RATE Returns the interest rate per period of an annuity 

178 RECEIVED  Returns the amount received at maturity for a fully invested 
security 

179 RRI  Returns an equivalent interest rate for the growth of an 
investment 

180 SLN Returns the straight-line depreciation of an asset for one period 

181 SYD Returns the sum-of-years' digits depreciation of an asset for a 
specified period 

182 TBILLEQ  Returns the bond-equivalent yield for a Treasury bill 

183 TBILLPRICE  Returns the price per $100 face value for a Treasury bill 

184 TBILLYIELD  Returns the yield for a Treasury bill 

185 VDB  Returns the depreciation of an asset for a specified or partial 
period by using a declining balance method 

186 XIRR Returns the internal rate of return for a schedule of cash flows 
that is not necessarily periodic 

187 XNPV  Returns the net present value for a schedule of cash flows that is 
not necessarily periodic 

188 YIELD  Returns the yield on a security that pays periodic interest 

189 YIELDDISC  Returns the annual yield for a discounted security; for example, a 
Treasury bill 

190 YIELDMAT  Returns the annual yield of a security that pays interest at maturity 

   

Informational  
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191 CELL Returns information about the formatting, location, or contents 
of a cell  Note    This is not available in Excel Web App. 

192 ERROR.TYPE Returns a number corresponding to an error type 

193 INFO  Returns information about the current operating 
environment.  Note    This is not available in Excel Web App. 

194 ISBLANK  Returns TRUE if the value is blank 

195 ISERR Returns TRUE if the value is any error value except #N/A 

196 ISERROR  Returns TRUE if the value is any error value 

197 ISEVEN  Returns TRUE if the number is even 

198 ISFORMULA  Returns TRUE if there is a reference to a cell that contains a 
formula 

199 ISLOGICAL  Returns TRUE if the value is a logical value 

200 ISNA Returns TRUE if the value is the #N/A error value 

201 ISNONTEXT Returns TRUE if the value is not text 

202 ISNUMBER  Returns TRUE if the value is a number 

203 ISODD  Returns TRUE if the number is odd 

204 ISREF  Returns TRUE if the value is a reference 

205 ISTEXT Returns TRUE if the value is text 

206 N Returns a value converted to a number 

207 NA Returns the error value #N/A 

208 SHEET  Returns the sheet number of the referenced sheet 

209 SHEETS  Returns the number of sheets in a reference 

210 TYPE  Returns a number indicating the data type of a value 

   

Logical  

211 AND Returns TRUE if all of its arguments are TRUE 

212 FALSE  Returns the logical value FALSE 

213 IF Specifies a logical test to perform 

214 IFERROR  Returns a value you specify if a formula evaluates to an error; 
otherwise, returns the result of the formula 

215 IFNA  Returns the value you specify if the expression resolves to #N/A, 
otherwise returns the result of the expression 

216 NOT Reverses the logic of its argument 

217 OR Returns TRUE if any argument is TRUE 

218 TRUE  Returns the logical value TRUE 

219 XOR Returns a logical exclusive OR of all arguments 

   

Lookup and Reference  

220 ADDRESS  Returns a reference as text to a single cell in a worksheet 

221 AREAS  Returns the number of areas in a reference 
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222 CHOOSE  Chooses a value from a list of values 

223 COLUMN  Returns the column number of a reference 

224 COLUMNS  Returns the number of columns in a reference 

225 FORMULATEXT  Returns the formula at the given reference as text 

226 GETPIVOTDATA Returns data stored in a PivotTable report 

227 HLOOKUP  Looks in the top row of an array and returns the value of the 
indicated cell 

228 HYPERLINK  Creates a shortcut or jump that opens a document stored on a 
network server, an intranet, or the Internet 

229 INDEX  Uses an index to choose a value from a reference or array 

230 INDIRECT  Returns a reference indicated by a text value 

231 LOOKUP  Looks up values in a vector or array 

232 MATCH  Looks up values in a reference or array 

233 OFFSET Returns a reference offset from a given reference 

234 ROW Returns the row number of a reference 

235 ROWS  Returns the number of rows in a reference 

236 RTD  Retrieves real-time data from a program that supports COM 
automation (Automation: A way to work with an application's 
objects from another application or development tool. Formerly 
called OLE Automation, Automation is an industry standard and a 
feature of the Component Object Model (COM).) 

237 TRANSPOSE Returns the transpose of an array 

238 VLOOKUP Looks in the first column of an array and moves across the row to 
return the value of a cell 

   

Math & Trigonometry  

239 ABS  Returns the absolute value of a number 

240 ACOS Returns the arccosine of a number 

241 ACOSH  Returns the inverse hyperbolic cosine of a number 

242 ACOT  Returns the arccotangent of a number 

243 ACOTH  Returns the hyperbolic arccotangent of a number 

244 AGGREGATE Returns an aggregate in a list or database 

245 ARABIC Converts a Roman number to Arabic, as a number 

246 ASIN  Returns the arcsine of a number 

247 ASINH  Returns the inverse hyperbolic sine of a number 

248 ATAN  Returns the arctangent of a number 

249 ATAN2  Returns the arctangent from x- and y-coordinates 

250 ATANH  Returns the inverse hyperbolic tangent of a number 

251 BASE  Converts a number into a text representation with the given radix 
(base) 
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252 CEILING  Rounds a number to the nearest integer or to the nearest 
multiple of significance 

253 CEILING.MATH  Rounds a number up, to the nearest integer or to the nearest 
multiple of significance 

254 CEILING.PRECISE  Rounds a number the nearest integer or to the nearest multiple of 
significance. Regardless of the sign of the number, the number is 
rounded up. 

255 COMBIN  Returns the number of combinations for a given number of objects 

256 COMBINA  Returns the number of combinations with repetitions for a given 
number of items 

257 COS Returns the cosine of a number 

258 COSH  Returns the hyperbolic cosine of a number 

259 COT Returns the cotangent of an angle 

260 COTH  Returns the hyperbolic cotangent of a number 

261 CSC  Returns the cosecant of an angle 

262 CSCH Returns the hyperbolic cosecant of an angle 

263 DECIMAL  Converts a text representation of a number in a given base into a 
decimal number 

264 DEGREES  Converts radians to degrees 

265 EVEN  Rounds a number up to the nearest even integer 

266 EXP Returns e raised to the power of a given number 

267 FACT Returns the factorial of a number 

268 FACTDOUBLE  Returns the double factorial of a number 

269 FLOOR  Rounds a number down, toward zero 

270 FLOOR.MATH  Rounds a number down, to the nearest integer or to the nearest 
multiple of significance 

271 FLOOR.PRECISE  Rounds a number down to the nearest integer or to the nearest 
multiple of significance. Regardless of the sign of the number, the 
number is rounded down. 

272 GCD Returns the greatest common divisor 

273 INT Rounds a number down to the nearest integer 

274 ISO.CEILING  Returns a number that is rounded up to the nearest integer or to 
the nearest multiple of significance 

275 LCM  Returns the least common multiple 

276 LN Returns the natural logarithm of a number 

277 LOG Returns the logarithm of a number to a specified base 

278 LOG10  Returns the base-10 logarithm of a number 

279 MDETERM  Returns the matrix determinant of an array 

280 MINVERSE  Returns the matrix inverse of an array 

281 MMULT  Returns the matrix product of two arrays 

282 MOD  Returns the remainder from division 

283 MROUND  Returns a number rounded to the desired multiple 
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284 MULTINOMIAL  Returns the multinomial of a set of numbers 

285 MUNIT  Returns the unit matrix or the specified dimension 

286 ODD  Rounds a number up to the nearest odd integer 

287 PI Returns the value of pi 

288 POWER  Returns the result of a number raised to a power 

289 PRODUCT  Multiplies its arguments 

290 QUOTIENT  Returns the integer portion of a division 

291 RADIANS  Converts degrees to radians 

292 RAND  Returns a random number between 0 and 1 

293 RANDBETWEEN Returns a random number between the numbers you specify 

294 ROMAN  Converts an Arabic numeral to Roman, as text 

295 ROUND  Rounds a number to a specified number of digits 

296 ROUNDDOWN  Rounds a number down, toward zero 

297 ROUNDUP Rounds a number up, away from zero 

298 SEC Returns the secant of an angle 

299 SECH  Returns the hyperbolic secant of an angle 

300 SERIESSUM  Returns the sum of a power series based on the formula 

301 SIGN Returns the sign of a number 

302 SIN  Returns the sine of the given angle 

303 SINH  Returns the hyperbolic sine of a number 

304 SQRT Returns a positive square root 

305 SQRTPI  Returns the square root of (number * pi) 

306 SUBTOTAL Returns a subtotal in a list or database 

307 SUM  Adds its arguments 

308 SUMIF  Adds the cells specified by a given criteria 

309 SUMIFS  Adds the cells in a range that meet multiple criteria 

310 SUMPRODUCT  Returns the sum of the products of corresponding array 
components 

311 SUMSQ  Returns the sum of the squares of the arguments 

312 SUMX2MY2  Returns the sum of the difference of squares of corresponding 
values in two arrays 

313 SUMX2PY2  Returns the sum of the sum of squares of corresponding values in 
two arrays 

314 SUMXMY2  Returns the sum of squares of differences of corresponding values 
in two arrays 

315 TAN  Returns the tangent of a number 

316 TANH  Returns the hyperbolic tangent of a number 

317 TRUNC  Truncates a number to an integer 

   

Statistical  
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318 AVEDEV  Returns the average of the absolute deviations of data points from 
their mean 

319 AVERAGE  Returns the average of its arguments 

320 AVERAGEA  Returns the average of its arguments, including numbers, text, and 
logical values 

321 AVERAGEIF  Returns the average (arithmetic mean) of all the cells in a range 
that meet a given criteria 

322 AVERAGEIFS  Returns the average (arithmetic mean) of all cells that meet 
multiple criteria 

323 BETA.DIST  Returns the beta cumulative distribution 

324 BETA.INV  Returns the inverse of the cumulative distribution for a specified 
beta distribution 

325 BINOM.DIST  Returns the individual term binomial distribution probability 

326 BINOM.DIST.RANGE  Returns the probability of a trial result using a binomial 
distribution 

327 BINOM.INV  Returns the smallest value for which the cumulative binomial 
distribution is less than or equal to a criterion value 

328 CHISQ.DIST  Returns the cumulative beta probability density 

329 CHISQ.DIST.RT Returns the one-tailed probability of the chi-squared distribution 

330 CHISQ.INV  Returns the cumulative beta probability density 

331 CHISQ.INV.RT  Returns the inverse of the one-tailed probability of the chi-squared 
distribution 

332 CHISQ.TEST  Returns the test for independence 

333 CONFIDENCE.NORM  Returns the confidence interval for a population mean 

334 CONFIDENCE.T Returns the confidence interval for a population mean, using a 
Student's t distribution 

335 CORREL  Returns the correlation coefficient between two data sets 

336 COUNT  Counts how many numbers are in the list of arguments 

337 COUNTA Counts how many values are in the list of arguments 

338 COUNTBLANK Counts the number of blank cells within a range 

339 COUNTIF Counts the number of cells within a range that meet the given 
criteria 

340 COUNTIFS  Counts the number of cells within a range that meet multiple 
criteria 

341 COVARIANCE.P  Returns covariance, the average of the products of paired 
deviations 

342 COVARIANCE.S  Returns the sample covariance, the average of the products 
deviations for each data point pair in two data sets 

343 DEVSQ  Returns the sum of squares of deviations 

344 EXPON.DIST  Returns the exponential distribution 

345 F.DIST  Returns the F probability distribution 

346 F.DIST.RT  Returns the F probability distribution 

347 F.INV  Returns the inverse of the F probability distribution 
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348 F.INV.RT  Returns the inverse of the F probability distribution 

349 F.TEST  Returns the result of an F-test 

350 FISHER  Returns the Fisher transformation 

351 FISHERINV  Returns the inverse of the Fisher transformation 

352 FORECAST  Returns a value along a linear trend 

353 FREQUENCY  Returns a frequency distribution as a vertical array 

354 GAMMA  Returns the Gamma value 

355 GAMMA.DIST  Returns the gamma distribution 

356 GAMMA.INV  Returns the inverse of the gamma cumulative distribution 

357 GAMMALN  Returns the natural logarithm of the gamma, Γ(x) 

358 GAMMALN.PRECISE  Returns the natural logarithm of the gamma, Γ(x) 

359 GAUSS  Returns 0.5 less than the standard normal cumulative distribution 

360 GEOMEAN  Returns the geometric mean 

361 GROWTH  Returns values along an exponential trend 

362 HARMEAN  Returns the harmonic mean 

363 HYPGEOM.DIST  Returns the hypergeometric distribution 

364 INTERCEPT  Returns the intercept of the linear regression line 

365 KURT  Returns the kurtosis of a data set 

366 LARGE  Returns the k-th largest value in a data set 

367 LINEST  Returns the parameters of a linear trend 

368 LOGEST  Returns the parameters of an exponential trend 

369 LOGNORM.DIST  Returns the cumulative lognormal distribution 

370 LOGNORM.INV  Returns the inverse of the lognormal cumulative distribution 

371 MAX Returns the maximum value in a list of arguments 

372 MAXA Returns the maximum value in a list of arguments, including 
numbers, text, and logical values 

373 MEDIAN  Returns the median of the given numbers 

374 MIN Returns the minimum value in a list of arguments 

375 MINA Returns the smallest value in a list of arguments, including 
numbers, text, and logical values 

376 MODE.MULT  Returns a vertical array of the most frequently occurring, or 
repetitive values in an array or range of data 

377 MODE.SNGL  Returns the most common value in a data set 

378 NEGBINOM.DIST  Returns the negative binomial distribution 

379 NORM.DIST  Returns the normal cumulative distribution 

380 NORM.INV  Returns the inverse of the normal cumulative distribution 

381 NORM.S.DIST  Returns the standard normal cumulative distribution 

382 NORM.S.INV  Returns the inverse of the standard normal cumulative distribution 

383 PEARSON  Returns the Pearson product moment correlation coefficient 

384 PERCENTILE.EXC  Returns the k-th percentile of values in a range, where k is in the 
range 0..1, exclusive 
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385 PERCENTILE.INC  Returns the k-th percentile of values in a range 

386 PERCENTRANK.EXC  Returns the rank of a value in a data set as a percentage (0..1, 
exclusive) of the data set 

387 PERCENTRANK.INC  Returns the percentage rank of a value in a data set 

388 PERMUT  Returns the number of permutations for a given number of objects 

389 PERMUTATIONA Returns the number of permutations for a given number of objects 
(with repetitions) that can be selected from the total objects 

390 PHI Returns the value of the density for a standard normal distribution 

391 POISSON.DIST Returns the Poisson distribution 

392 PROB Returns the probability that values in a range are between two 
limits 

393 QUARTILE.EXC  Returns the quartile of the data set, based on percentile values 
from 0..1, exclusive 

394 QUARTILE.INC  Returns the quartile of a data set 

395 RANK.AVG  Returns the rank of a number in a list of numbers 

396 RANK.EQ  Returns the rank of a number in a list of numbers 

397 RSQ  Returns the square of the Pearson product moment correlation 
coefficient 

398 SKEW Returns the skewness of a distribution 

399 SKEW.P  Returns the skewness of a distribution based on a population: a 
characterization of the degree of asymmetry of a distribution 
around its mean 

400 SLOPE  Returns the slope of the linear regression line 

401 SMALL Returns the k-th smallest value in a data set 

402 STANDARDIZE  Returns a normalized value 

403 STDEV.P  Calculates standard deviation based on the entire population 

404 STDEV.S  Estimates standard deviation based on a sample 

405 STDEVA  Estimates standard deviation based on a sample, including 
numbers, text, and logical values 

406 STDEVPA  Calculates standard deviation based on the entire population, 
including numbers, text, and logical values 

407 STEYX  Returns the standard error of the predicted y-value for each x in 
the regression 

408 T.DIST  Returns the Percentage Points (probability) for the Student t-
distribution 

409 T.DIST.2T  Returns the Percentage Points (probability) for the Student t-
distribution 

410 T.DIST.RT  Returns the Student's t-distribution 

411 T.INV  Returns the t-value of the Student's t-distribution as a of the 
probability and the degrees of freedom 

412 T.INV.2T  Returns the inverse of the Student's t-distribution 

413 T.TEST  Returns the probability associated with a Student's t-test 

414 TREND  Returns values along a linear trend 

http://www.carltoncollins.com/
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753143&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753218&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753142&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752906&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753264&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753265&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753141&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752897&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753221&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753140&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753220&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753150&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752877&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752869&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753266&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752867&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752866&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752862&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753129&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753139&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752860&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752859&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752858&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753241&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753138&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753130&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753225&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753136&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102753135&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955
http://office.microsoft.com/client/15/help/preview?AssetId=HA102752832&lcid=1033&NS=EXCEL&Version=15&tl=2&CTT=5&origin=HA102752955


Excel 2013 for CPAs 

www.CarltonCollins.com Page 105 Copyright May 2013 

 

415 TRIMMEAN  Returns the mean of the interior of a data set 

416 VAR.P  Calculates variance based on the entire population 

417 VAR.S  Estimates variance based on a sample 

418 VARA  Estimates variance based on a sample, including numbers, text, 
and logical values 

419 VARPA Calculates variance based on the entire population, including 
numbers, text, and logical values 

420 WEIBULL.DIST Returns the Weibull distribution 

421 Z.TEST  Returns the one-tailed probability-value of a z-test 

 
 

 

Text   

422 ASC Changes full-width (double-byte) English letters or katakana within 
a character string to half-width (single-byte) characters 

423 BAHTTEXT  Converts a number to text, using the ß (baht) currency format 

424 CHAR  Returns the character specified by the code number 

425 CLEAN  Removes all nonprintable characters from text 

426 CODE  Returns a numeric code for the first character in a text string 

427 CONCATENATE Joins several text items into one text item 

428 DBCS Changes half-width (single-byte) English letters or katakana within 
a character string to full-width (double-byte) characters 

429 DOLLAR  Converts a number to text, using the $ (dollar) currency format 

430 EXACT  Checks to see if two text values are identical 

431 FIND, FINDBs  Finds one text value within another (case-sensitive) 

432 FIXED  Formats a number as text with a fixed number of decimals 

433 LEFT, LEFTBs Returns the leftmost characters from a text value 

434 LEN, LENBs  Returns the number of characters in a text string 

435 LOWER  Converts text to lowercase 

436 MID, MIDBs  Returns a specific number of characters from a text string starting 
at the position you specify 

437 NUMBERVALUE  Converts text to number in a locale-independent manner 

438 PHONETIC  Extracts the phonetic (furigana) characters from a text string 

439 PROPER  Capitalizes the first letter in each word of a text value 

440 REPLACE, REPLACEBs  Replaces characters within text 

441 REPT  Repeats text a given number of times 

442 RIGHT, RIGHTBs  Returns the rightmost characters from a text value 

443 SEARCH, SEARCHBs  Finds one text value within another (not case-sensitive) 

444 SUBSTITUTE Substitutes new text for old text in a text string 

445 T Converts its arguments to text 

446 TEXT  Formats a number and converts it to text 

447 TRIM  Removes spaces from text 
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448 UNICHAR  Returns the Unicode character that is references by the given 
numeric value 

449 UNICODE  Returns the number (code point) that corresponds to the first 
character of the text 

450 UPPER Converts text to uppercase 

451 VALUE  Converts a text argument to a number 

   

User defined that are installed with add-ins 
452 CALL Calls a procedure in a dynamic link library or code resource 

453 EUROCONVERT  Converts a number to euros, converts a number from euros to a 
euro member currency, or converts a number from one euro 
member currency to another by using the euro as an intermediary 
(triangulation) 

454 REGISTER.ID  Returns the register ID of the specified dynamic link library (DLL) or 
code resource that has been previously registered 

455 SQL.REQUEST Connects with an external data source and runs a query from a 
worksheet, then returns the result as an array without the need 
for macro programming 

   

Web   

453 ENCODEURL  Returns a URL-encoded string 

454 FILTERXML  Returns specific data from the XML content by using the specified 
XPath 

455 WEBSERVICE    
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The 171 Most Relevant and Important Functions to CPAs 
(According to Carlton’s best guess) 

 
The numbers in parenthesis correspond to the order  

in which each function appears on the All Functions worksheet 
 

Open an Excel file Containing Function Examples: 
http://www.ASAResearch.com/web/functions.xlsx    

 
The goal of this summary is to help CPAs focus on learning the most relevant and important 
functions first, without having to waste time wading through all 455 functions. Excel 2013 
provides 455 functions, but in most cases only 37.5% of them are relevant and important to CPAs. 
Consider, how often do you expect to use the CRITBINOMIALDIST function? How often will the 
IMAGINARY function have relevance to your work? When did any CPA ever calculate depreciation 
using the SYD method (other than on a CPA example question). The reality is that CPAs don’t 
have to know all of the functions to master Excel, you’ll conquer Excel just by learning 37.5% of 
the included functions.  

 
1. IF (213) - Specifies a logical test to perform. 

2. SUM (307) - Adds its arguments. 

3. SUBTOTAL (306) - Returns a subtotal in a list or database. 

4. SUMIF (308) - Adds the cells specified by a given criteria. 

5. COUNT (336) - Counts how many numbers are in the list of arguments. 

6. COUNTA (337) - Counts how many values are in the list of arguments. 

7. AVERAGE (319) - Returns the average of its arguments. 

8. COUNTBLANK (338) - Counts the number of blank cells within a range. 

9. COUNTIF (339) - Counts the number of cells within a range that meet the given criteria. 

10. VALUE (451) - Converts a text argument to a number. 

11. TEXT (446) - Formats a number and converts it to text. 

12. VLOOKUP (238) - Looks in the first column of an array and moves across the row to 

return the value of the indicated cell. 

13. HLOOKUP (227) - Looks in the top row of an array and returns the value of the indicated 

cell. 

14. TWO WAY LOOKUP – Using both VLOOKUP and HLOOKUP together. 

15. LOOKUP (231) - Looks up values in a vector or array. 

16. MATCH (232) - Looks up values in a reference or array. 

17. TRIM (447) - Removes spaces from text. 

18. PROPER (439) - Capitalizes the first letter in each word of a text value. 

19. LOWER (435) - Converts text to lowercase. 

20. UPPER (450) - Converts text to uppercase. 
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21. LEFT, LEFTBs (433) - Returns the leftmost characters from a text value. 

22. RIGHT, RIGHTBs (442) - Returns the rightmost characters from a text value. 

23. MID, MIDBs (436) - Returns a specific number of characters from a text string starting at 

the position. 

24. FIND, FINDBs (431) - Finds one text value within another (case-sensitive). 

25. SUBSTITUTE (444) - Substitutes new text for old text in a text string. 

26. LEN, LENBs (434) - Returns the number of characters in a text string. 

27. REPLACE, REPLACEBs (440) - Replaces characters within text. 

28. CONCATENATE (427) - Joins several text items into one text item. 

29. CLEAN (425) - Removes all nonprintable characters from text. 

30. NOW (71) - Returns the serial number of the current date and time. 

31. TODAY (75) - Returns the serial number of today's date. 

32. DATE (58) - Returns the serial number of a particular date. 

33. MONTH (68) - Converts a serial number to a month. 

34. DAY (60) - Converts a serial number to a day of the month. 

35. YEAR (80) - Converts a serial number to a year. 

36. WEEKDAY (76) - Converts a serial number to a day of the week. 

37. ROUND (295) - Rounds a number to a specified number of digits. 

38. ROUNDDOWN (296) - Rounds a number down, toward zero. 

39. ROUNDUP (297) - Rounds a number up, away from zero. 

40. MAX (371) - Returns the maximum value in a list of arguments. 

41. DMAX (50) - Returns the maximum value from selected database entries. 

42. MIN (374) - Returns the minimum value in a list of arguments. 

43. DMIN (51) - Returns the minimum value from selected database entries. 

44. MEDIAN - Returns the median of the given numbers. 

45. MODE - Returns the most common value in a data set. 

46. PERCENTILE (25) - Returns the k-th percentile of values in a range. 

47. PERCENTRANK (26) - Returns the percentage rank of a value in a data set. 

48. PMT (171) - Returns the periodic payment for an annuity. 

49. NPV (165) - Returns the net present value of an investment based on a series of periodic 

cash flows. 

50. DSUM (55) - Adds the numbers in the field column of records in the database that match 

the criteria. 

51. DCOUNT (47) - Counts the cells that contain numbers in a database. 

52. DCOUNTA (48) - Counts nonblank cells in a database. 

53. AND (211) - Returns TRUE if all of its arguments are TRUE. 

54. OR (217) - Returns TRUE if any argument is TRUE. 

55. CHOOSE (222) - Chooses a value from a list of values. 
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56. TIME (73) - Returns the serial number of a particular time. 

57. FV (155) - Returns the future value of an investment. 

58. IRR (159) - Returns the internal rate of return for a series of cash flows. 

59. YIELD (188) - Returns the yield on a security that pays periodic interest. 

60. CELL (191) - Returns information about the formatting, location, or contents of a 

cell.  Note  

61. INFO (193) - Returns information about the current operating environment.  Note    This 

is not avail. 

62. ERROR.TYPE (192) - Returns a number corresponding to an error type. 

63. ISBLANK (194) - Returns TRUE if the value is blank. 

64. ISNA (200) - Returns TRUE if the value is the #N/A error value. 

65. GETPIVOTDATA (226) - Returns data stored in a PivotTable report. 

66. HYPERLINK (228) - Creates a shortcut or jump that opens a document stored on a 

network server, an in. 

67. TRANSPOSE (237) - Returns the transpose of an array. 

68. ABS (239) - Returns the absolute value of a number. 

69. RAND (292) - Returns a random number between 0 and 1. 

70. RANDBETWEEN (293) - Returns a random number between the numbers you specify. 

71. REPT (441) - Repeats text a given number of times. 

72. SLN (180) - Returns the straight-line depreciation of an asset for one period. 

73. SYD - Returns the sum-of-years' digits depreciation of an asset for a specified period. 

74. DDB (149) - Returns the depreciation of an asset for a specified period by using the 

double-declining balance method. 

75. DGET (49) - Extracts from a database a single record that matches the specified criteria. 

76. ADDRESS (220) - Returns a reference as text to a single cell in a worksheet. 

77. AGGREGATE (244) - Returns an aggregate in a list or database. 

78. FORECAST (352) - Returns a value along a linear trend. 

79. GROWTH (361) - Returns values along an exponential trend. 

80. LARGE (366) - Returns the k-th largest value in a data set. 

81. NOT (216) - Reverses the logic of its argument. 

82. OFFSET (233) - Returns a reference offset from a given reference. 

83. PEARSON (383) - Returns the Pearson product moment correlation coefficient. 

84. PV (176) - Returns the present value of an investment. 

85. RATE (177) - Returns the interest rate per period of an annuity. 

86. SEARCH, SEARCHBs (443) - Finds one text value within another (not case-sensitive). 

87. SMALL (401) - Returns the k-th smallest value in a data set. 

88. XIRR (186) - Returns the internal rate of return for a schedule of cash flows that is not 

necessarily. 
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89. XOR (219) - Returns a logical exclusive OR of all arguments. 

90. AVERAGEIF (321) - Returns the average (arithmetic mean) of all the cells in a range that 

meet a give. 

91. AVERAGEIFS (322) - Returns the average (arithmetic mean) of all cells that meet multiple 

criteria. 

92. COLUMN (223) - Returns the column number of a reference. 

93. COLUMNS (224) - Returns the number of columns in a reference. 

94. CONVERT (95) - Converts a number from one measurement system to another. 

95. COUNTIFS (340) - Counts the number of cells within a range that meet multiple criteria. 

96. DATEVALUE (59) - Converts a date in the form of text to a serial number. 

97. DECIMAL (263) - Converts a text representation of a number in a given base into a 

decimal number. 

98. DOLLAR (429) - Converts a number to text, using the $ (dollar) currency format. 

99. EXACT (430) - Checks to see if two text values are identical. 

100. FORMULATEXT (225) - Returns the formula at the given reference as text. 

101. HOUR (65) - Converts a serial number to an hour. 

102. INDEX (229) - Uses an index to choose a value from a reference or array. 

103. ISERR (195) - Returns TRUE if the value is any error value except #N/A. 

104. ISERROR (196) - Returns TRUE if the value is any error value. 

105. ISFORMULA (198) - Returns TRUE if there is a reference to a cell that contains a formula. 

106. KURT (365) - Returns the kurtosis of a data set. 

107. MINUTE (67) - Converts a serial number to a minute. 

108. NA (207) - Returns the error value #N/A. 

109. PPMT (172) - Returns the payment on the principal for an investment for a given period. 

110. ROW (234) - Returns the row number of a reference. 

111. ROWS (235) - Returns the number of rows in a reference. 

112. RSQ (397) - Returns the square of the Pearson product moment correlation coefficient. 

113. SHEET (208) - Returns the sheet number of the referenced sheet. 

114. SHEETS (209) - Returns the number of sheets in a reference. 

115. SKEW (398) - Returns the skewness of a distribution. 

116. SKEW.P (399) - Returns the skewness of a distribution based on a population: a 

characterization of t. 

117. SUMIFS (309) - Adds the cells in a range that meet multiple criteria. 

118. T (445) - Converts its arguments to text. 

119. TYPE (210) - Returns a number indicating the data type of a value. 

120. WEEKNUM (77) - Converts a serial number to a number representing where the week 

falls numerically with a year. 
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121. WORKDAY (78) - Returns the serial number of the date before or after a specified 

number of workdays. 

122. XNPV (187) - Returns the net present value for a schedule of cash flows that is not 

necessarily periodic. 

123. EFFECT (154) - Returns the effective annual interest rate. 

124. INT (273) - Rounds a number down to the nearest integer. 

125. INTERCEPT (364) - Returns the intercept of the linear regression line. 

126. RANK (29) - Returns the rank of a number in a list of numbers. 

127. RRI (179) - Returns an equivalent interest rate for the growth of an investment. 

128. SIGN (301) - Returns the sign of a number. 

129. SLOPE (400) - Returns the slope of the linear regression line. 

130. CEILING (252) - Rounds a number to the nearest integer or to the nearest multiple of 

significance. 

131. CEILING.MATH (253) - Rounds a number up, to the nearest integer or to the nearest 

multiple of significance. 

132. CHAR (424) - Returns the character specified by the code number. 

133. CODE (426) - Returns a numeric code for the first character in a text string. 

134. DAVERAGE (46) - Returns the average of selected database entries. 

135. DAYS (61) - Returns the number of days between two dates. 

136. FALSE (212) - Returns the logical value FALSE. 

137. FIXED (432) - Formats a number as text with a fixed number of decimals. 

138. FLOOR.MATH (270) - Rounds a number down, to the nearest integer or to the nearest 

multiple of significance . 

139. IFERROR (214) - Returns a value you specify if a formula evaluates to an error; 

otherwise, returns t. 

140. IFNA (215) - Returns the value you specify if the expression resolves to #N/A, otherwise 

returns the. 

141. INDIRECT (230) - Returns a reference indicated by a text value. 

142. IPMT (158) - Returns the interest payment for an investment for a given period. 

143. ISNONTEXT (201) - Returns TRUE if the value is not text. 

144. ISNUMBER (202) - Returns TRUE if the value is a number. 

145. MAXA (372) - Returns the maximum value in a list of arguments, including numbers, 

text, and logical . 

146. MINA (375) - Returns the smallest value in a list of arguments, including numbers, text, 

and logical. 

147. N (206) - Returns a value converted to a number. 

148. NETWORKDAYS (69) - Returns the number of whole workdays between two dates. 

149. RECEIVED (178) - Returns the amount received at maturity for a fully invested security. 
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150. SECOND (72) - Converts a serial number to a second. 

151. SUMPRODUCT (310) - Returns the sum of the products of corresponding array 

components. 

152. TREND (414) - Returns values along a linear trend. 

153. TRUE (218) - Returns the logical value TRUE. 

154. ACCRINT (136) - Returns the accrued interest for a security that pays periodic interest. 

155. ACCRINTM (137) - Returns the accrued interest for a security that pays interest at 

maturity. 

156. ISPMT (160) - Calculates the interest paid during a specific period of an investment. 

157. ISTEXT (205) - Returns TRUE if the value is text. 

158. LINEST (367) - Returns the parameters of a linear trend. 

159. CUBEKPIMEMBER (39) - Returns a key performance indicator (KPI) property and displays 

the KPI name in. 

160. DELTA (99) - Tests whether two values are equal. 

161. EVEN (265) - Rounds a number up to the nearest even integer. 

162. ISEVEN (197) - Returns TRUE if the number is even. 

163. ISODD (203) - Returns TRUE if the number is odd. 

164. ISOWEEKNUM (66) - Returns the number of the ISO week number of the year for a given 

date. 

165. LOGEST (368) - Returns the parameters of an exponential trend. 

166. ODD (286) - Rounds a number up to the nearest odd integer. 

167. PRODUCT (289) - Multiplies its arguments. 

168. QUOTIENT (290) - Returns the integer portion of a division. 

169. STDEVP (31) - Calculates standard deviation based on the entire population. 

170. TBILLEQ (182) - Returns the bond-equivalent yield for a Treasury bill. 

171. TBILLYIELD (184) - Returns the yield for a Treasury bill. 

172. TIMEVALUE (74) - Converts a time in the form of text to a serial number. 
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Macros 
  
Macros offer a powerful and flexible way to extend the features of Excel. They allow the 
automation of repetitive tasks such as printing, formatting, configuring, or otherwise 
manipulating data in Excel. In its’ simplest form, a macro is a recording of your keystrokes. While 
macros represent one of the stronger features found in Excel, they are rather easy to create and 
use. There are six major points that I like to make about macros as follows.  
  

Six Major Points for Creating Macros 
 

1.     Record, Use Excel, Stop Recording – To create a macro, simply turn on the macro recorder, use 
Excel as you normally do, then turn off the recorder. Presto – you have created a macro. While 
the process is simple from the user’s point of view, underneath the covers Excel creates a Visual 
Basic subroutine using sophisticated Visual Basic programming commands.   
  

2.     Macro Location – Macros can be stored in either of two locations, as follows: 
  
a.      The workbook you are using, or  
b.      Your Personal Macro Workbook (which by default is hidden from view) 
  
If your macro applies to all workbooks, then store it in the Personal Macro Workbook so it will 
always be available in all of your Excel workbooks; otherwise store it in your current workbook. 
A macro stored in your current workbook will be embedded and included in the workbook, even 
if you e-mail the workbook to another user.  
  

3.     Assign your Macro to an Icon, Text or a Button – To make it easy to run your macro, you should 
assign it to a toolbar icon so it will always be available no matter which workbooks you have 
open. If the macro applies only to your current workbook, then assign it to Text or a macro Button 
so it will be quickly available in your current workbook. 
  

4.    Absolute versus Relative Macros – An “Absolute” macro will always affect the same cells each 
time whereas a “Relative” macro will affect those cells relative to where your cursor is positioned 
when you invoke the macro. It is crucial that you understand the difference. 
  

5.   Editing Macros – Once created, you can view and/or edit your macro using the View Macros 
option. This will open the macro subroutine in a Visual basic programming window and provide 
you with a plethora of VB tools. 
  

6.  Advanced Visual Basic Programming – For the truly ambitious CPA, in the Visual Basic 
Programming window, you have the necessary tools you need to build very sophisticated macros 
with dialog boxes, drop down menu options, check boxes, radio buttons – the whole works. I 
invite you to knock yourself out. To see all of this power, turn on the “Developer Tab” in “Excel 
Options” (see below).  
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Presented below are more detailed comments and step-by-step instructions for creating and 
invoking macros, followed by some example macros.  
 

Steps for Creating A Macro 
  
1. Launch Macro Recorder - Select Record Macros on the View tab, or in the Code Group on 

the Developer Tab. 
 
A. Macro Name - Enter a name for the macro In the Macro Name box. 

 
a. The first character of the macro name must be a letter.  
b. Subsequent characters can be letters, numbers, or underscore characters.  
c. Spaces cannot be used in a macro name (an underscore character is often used as 

a word separator.  
d. If you use a macro name that is also a cell reference, you may get an error message 

that the macro name is not valid. 
 

B. Shortcut – (This is optional) Assign a CTRL key combination (such as CTRL+A to run the 
macro by typing any lowercase letter or uppercase letter that you want to use in the 
Shortcut key box. 

 
a. The shortcut key will override any equivalent default Excel shortcut key while the 

workbook that contains the macro is open.  
 

C. Macro Location - In the Store Macro In dropdown box, select the workbook where you 
want to store the macro.  

 
a. If you want a macro to be available in all Excel workbooks, select Personal Macro 

Workbook. When you select Personal Macro Workbook, Excel creates a hidden 
personal macro workbook (Personal.xlsb) if it does not already exist, and saves the 
macro in this workbook.  
 

i. In Windows Vista, this workbook is saved in the 
C:\Users\username\AppData\Local\Microsoft\Excel\XLStart folder.  

ii. In Microsoft Windows XP, this workbook is saved in the C:\Documents 
andSettings\user name\Application Data\Microsoft\Excel\XLStart folder.  

iii. Workbooks in the XLStart folder are opened automatically whenever 
Excel starts.  

b. Note - If you want the macro in the personal macro workbook to be run 
automatically in another workbook, you must also save that workbook in the 
XLStart folder so that both workbooks are opened when Excel starts. 
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D. Macro Description - In the Description box, type a description of the macro.  
 

E. Start Recording - Click OK to start recording.  
 

F. Start Typing - Perform the actions that you want to record. New in Excel 2010, macros 
can now record the manipulation of objects, such as inserting or moving a text box.  

 
G. Stop Recording – When you are done click “Stop Recording” in the “Code Group” On the 

“Developer Tab”. You can also click Stop Recording on the left side of the status bar. 
 

H. Assign the Macro to an Object, Graphic in the Worksheet – Insert an object (like a Star 
shape or text box) or graphic image (like a picture) in your worksheet, then right-click on 
that object or graphic image and select Assign Macro from the popup menu. In the Macro 
Name box, select the macro that you want to assign to that object or graphic image and 
click OK. 
 

2. Menu Navigation Not Recorded – Keep in mind that when you record a macro, the macro 
recorder records all the steps required to complete the actions that you want your macro to 
perform. Navigation on the Ribbon is not included in the recorded steps, only the commands 
that are executed are recorded in the macro. 

 
3. Turn On The Developer Tab – By default, the Developer tab is turned off, but you can turn it 

on in Excel 2010 by clicking the File tab select Options, Customize the Ribbon, and check the 
checkbox next to Developer Tab.  In Excel 2007, click the Microsoft Office Start Button in 
Excel 2007, select Excel Options, and under the Popular category, Top options for working 
with Excel, select the Show Developer tab in the Ribbon check box, and then click OK. 

 

 
 

4. Enable Macros – If the macro functions are disabled, you can enable them by selecting Macro 
Security in the Code group on the Developer tab as shown below. 
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Under Macro Settings, click Enable All Macros (this is not recommended by Microsoft because 
potentially dangerous code can then run without your approval), and then click OK.  
  

5. Example Macros  

 
A. Headers and Footers Macro – Start recording a new macro called Insert_Headers. Select 

all of the worksheets, then from the Page Layout tab, double click the Page Setup dialog 

box button to display the Page Setup dialog box. Continue to customize the header and 

footers to include page numbers, date and time stamps, file locations, tab names, etc. 

Assign the macro to an Icon on your toolbar or Quick Access Bar for quick and easy access. 

Thereafter, inserting headers and footers in your worksheets will be a breeze. 

 
B. Print Macros – Do you have a workbook containing multiple reports that you frequently 

print? If so, insert macro buttons to print each individual report, a group of reports, and 

even multiple reports, and in the future reporting will be a snap.  

 
C. Delete Data Macro – Do you have a frequently used template that contains a lot of 

variables? If so, create a macro that visits each cell and erases that data, resetting the 

worksheet for use in a new set of criteria. Assign the macro to a macro button and you 

will never again have old assumptions mixed in with your newer template. 

 
D. Macro Case Study – Carlton’s Copy Shop – See the following chapter for a detailed case 

study for using macros.  
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Copy Shop Sales Order Macro Case Study 
 

  
 
As an accounting software installer, I’ve learned from experience that most businesses can pick 
blindly from among the top accounting systems in the world and pretty much get the job done. 
From one business to the next, accounts payable needs, payroll needs, trial balance needs, 
reporting needs, and even inventory needs are similar and well covered by today’s top accounting 
systems. However, there is one area which differs dramatically  - and that area is in the sales 
order. It turns out that each company sells differing kinds of products and services with options 
so varied, that few accounting systems are prepared to handle those needs. In this situation, I 
make a bold claim that an Excel template can be easily used to fill in the missing gaps and 
supplement any accounting software system to provide excellent order taking capabilities. 
 
In this case study, let us assume that we are working with a small copy shop – a small family 
owned company with about $300,000 in revenue. In this case they have determined that 
QuickBooks meets all of there needs, except for order taking. Therefore our goal will be to build  
a Sales Order system using Excel in only a few minutes. Listed below are the key elements that 
you will learn in this case study: 
 

1. Neat and Organized Worksheet Design 

2. =NOW() 
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3. Data Validation Lists 

4. =VLOOKUP 

5. Creating Macro Buttons 

6. Creating Macros 

a. Simple Print macro 

b. Simple erase and increment invoice number macro 

c. More complicated posting macro 

7. Relative versus Absolute Macros 

8. Named Cells 

9. Worksheet Protection 

10. Adding Logic to the Product Configurator 

11. Combining Macros 

12. Locating the database on another sheet 

 
Think about a copy shop for a minute, what is so difficult about taking an order in a copy shop? 
It is the options. How many copies would you like? Do you want that printed on front and back? 
Stapled or Bound? What kind of binding? What size paper? What color paper? What pound 
paper? Do you want regular or fast delivery? These are all standard questions asked by a copy 
shop, yet QuickBooks, nor any high end accounting system is able to take such an order. Even the 
million dollar solutions aren’t equipped to take such an order. These companies must instead 
resort to purchasing a software application called a “product configurator”, solutions which can 
costs $75,000 to $750,000 or more. To make matters more difficult, there are often rules 
associated with various options – for example, when ordering a car, if you order the sun roof 
option, you can not also order the T-Top option. Product configurators must account for and 
accommoate these types of situations. 
 
1. Let us begin by simply labeling our sales order form. As you can see in the screen to the right, 

we’ve added some labels and highlighted some data input fields with yellow background and 
gridline borders.  
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(For purposes of this case study, we will only build in options for color and size, but once you 
get the hang of it, adding in additional options for paper weight, binding, duplex printing, etc 
is a rather simple matter.) 

 
2. =NOW() – Next we type in the Excel Function =NOW(). This will cause Excel to display the 

computer’s date and time each time an order is produced. You can see the =NOW() 
function in the formula bar and the results displayed in cell B2 below. 
 

 
 

3. Calculations for Base Rate – Next we add simple calculations to multiply the total number 
of pages to be copied by the total number of copies and the base rate per copy. To make 
it easier to visualize, I have added some customer data. (The formula contained in cell B11 
is displayed in the formula bar.)  
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4. Color Options – Next I created a table of the color options along with a sur-charge rate 
per page for each color. Notice that there is a “zero” sur-charge when selecting white 
paper. Make sure to sort your table in descending order because we plan to refer to that 
table via a Lookup function – and as we all know, lookup functions do not work properly 
unless the table array is sorted in descending order. To make the table of options more 
readable, I applied gridlines and a greenish background.  

 

 
 

5. Data List Validation – Now this is where the excitement begins. Next I create a data 
validation list in cell B13 using column one of my options table. To do this, select B13, and 
choose Data validation from the Data Ribbon. Next select List and use the Cell Chooser to 
highlight the options in column one of your color options table.  
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6. =VLOOKUP – Next I inserted a =VLOOKUP function in cell B14 to return the Sur-Charge 
rate based on the Color Selected. 
 

 
 
Notice that when you select different colors in cell B13, the rate in Cell B14 changes 
according to the Color Option table. 
 

7. Size Options - Repeat steps 4,5 & 6 above to also create Size Options.  
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8. Invoice Total – From here it is an easy step to add calculations to total the invoice. Of 
course your complete invoice would also include sales tax calculations as well. Our 
example is kept as simple as possible to make sure that the key points come across as 
easy as possible. Here’s what we have so far: 
 

 
 

9. Macro Buttons – To make the Sales Order form easier to use, next we will add three 
macro buttons. We start this process by creating a single text box, and use the Drawing 
Tools to make it look fancy. Here are steps: 
 

http://www.carltoncollins.com/


Excel 2013 for CPAs 

www.CarltonCollins.com Page 123 Copyright May 2013 

 

      
 

10. Create the Print Macro – Next create a print macro by selecting “Macro, Record Macro” 
from the “View Ribbon” (make sure that no spaces are used in your macro name and save 
the macro to “This Workbook). Set the “Print Area” appropriately to display your Sales 
Order Form. Next simply highlight your Sales Order Form and print three copies, then stop 
recording your macro by selecting “Macro, Stop Recording” from the “View Ribbon”. 
Once completed assign the Macro to the Print Sales Order Button by right mouse clicking 
and selecting “Assign Macro”.   The right click menu and the Assign Macro Dialog box are 
shown in the two screens below. 
 

      
 

You want to print three copies of the Sales Order as follows: One for your customer’s 
records; One for your product people to follow when making the copies, and one for 
bookkeeper to use when entering the invoice amount into QuickBooks.  

 
11. Additional Macro Buttons – Next right click on the edge of the existing macro button 

twice, and choose “Copy”; then click away from the button and Paste twice. This will 
create two exact copies of your macro button. (You must right click twice on the edge of 
the button to display the second menu of options.)  
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Next select the “Select Objects” menu option from the “Home” Ribbon’s “Find and Select” 
menu in the “Edit” Group. Then lasso the three buttons and from the “Drawing Tools”, 
use the Alignment tools to left justify and Distribute Vertically the three buttons. 

 

        
 

The results will appear as follows: 
 

 
 

Press escape to deselect the “Object Pointer” tool, and return your cursor to normal. 
 

12. Post Sales Order Macro Button – Next I created a macro to post the sales order 
information to a database. This is complicated and I will demonstrate several teaching 
points in class to help you fully understand the process of writing a combination relative 
and absolute Here are the steps: 
 

a. Relabel the second Macro Button to Read “Post Sales Order”. This will require you 
to first right mouse click on the button and select the text, or if you prefer, remove 
the macro before continuing.  

b. Highlight cells B2 thru B21 and label that range “salesorderdata” using the Name 
Box. 

c. Go to Cell H1 and enter the phrase “Database” in cell H1. 

http://www.carltoncollins.com/


Excel 2013 for CPAs 

www.CarltonCollins.com Page 125 Copyright May 2013 

 

d. Label cell H1 “database” using the Name Box. 

e. Copy the labels in cells A2 thru A21 and Paste Transpose them to cell H2. 

f. Start recording a macro named “postsalesorder”. 

g. Click the “Use Relative References” option from the Macros Group on the View 
Ribbon. 

h. Press the F5 key to launch the GoTo Dialog Box.  

i. Select the range “salesorderdata” by double clicking on the word 
“salesorderdata”. 

j. With your cursor hovering above the selected range, right mouse click and choose 
“Copy”. 

k. Press the F5 key to launch the GoTo Dialog Box.  

l. Select the range “database” by double clicking on the word “database”. 

m. Press the End key, followed by the Down Arrow. (You will now be on the last row.) 

n. Press the Down Arrow. (You will now be on a blank row underneath the last row.) 

o. With your cursor hovering above the selected range, right mouse click and choose 
“Paste Special”. 

p. In the paste Special Dialog Box, check Values and Check Transpose, and click OK. 

q. Place your cursor on cell A1. 

r. Stop recording the macro by selecting “Macro, Stop Recording” from the “View 
Ribbon. 

s. Assign the newly recorded macro to the Post Sales order macro Button. 

t. Select Column H and format it to display Time and Date. 

u. Adjust the width of your database columns to your preference. 

 
13. New Sales Order Macro Button – Finally, edit the Third macro Button to Read “New sales 

Order” and create a macro that selects the yellow background data cells and deletes the 
contents. (Make sure to toggle the “Use Relative References” option off because this 
macro needs to be an absolute macro.) (Also make sure to select Cell B4, then hold the 
CTRL key down while you also select the other yellow back ground cells). Before you Stop 
Recording this macro, click on cell B4 so your cursor will be in the correct place to start 
recording a new sales order. 
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14. Testing – Test your three macros by filling in new sales order information, then click the 
three macro buttons in sequence to print, post and delete your data. 
 

15. Unlock Data Input Cells – Next, select the cells containing the yellow background and also 
select the database columns (Hold the CTRL key down to make multiple selections. Then 
format the those cells to unlock them by right mouse clicking atop your selection and 
selecting “Format Cells, and unchecking the Locked Box on the protection tab – as shown 
below: 
 

 
 

16. Protect Your Worksheet - Finally turn on worksheet protection by selecting “Protect 
Sheet” from the Review ribbon. Enter a password and repeat the password. This will 
prevent you or others from making accidental changes to the formulas and data 
contained in your template. 
 

17. Keep in Mind – This case study covered the basics, but you could enhance this template 
a number of ways. Here are a few example hints: 
 

a. Combine the three macro buttons into one button that performs all tasks – 
printing, posting, and deleting. 

b. You might also add a grid for matrix pricing – pricing for volume below 1,000, 
5,000, and 10,000 total pages copied. 

http://www.carltoncollins.com/


Excel 2013 for CPAs 

www.CarltonCollins.com Page 127 Copyright May 2013 

 

c. You might add an invoice number to the top of the page. Each time you post, your 
macro might also create a temporary formula in an empty cell that refers to the 
invoice number and adds one, then copies pastes that result atop the invoice 
number cell using the paste value command. Make sure the macro then deletes 
the formula in the temporary cell. 

d. You could easily add more options to your order form.  

e. Notice that we also included an option to decrease our price if a smaller paper size 
is selected.  

f. The sales order form could be dressed up to look far more professional. Colors, 
grids, logos, etc. could all be added to make the sales order form match the 
accounting system, for example. 

g. You could copy the worksheet and edit a second order for to be used in different 
situations. For example, Worksheet A might contain an order form that charges 
regular rates when a regular customer enters the store, and Worksheet B could 
charge higher rates when a lawyer enters the store – and so on. 

h. The resulting database will continue to compile each sales order as posted, adding 
new orders to the bottom of the database area each time you post. 

i. The bookkeeper need only record the date, customer name, address, and total 
amount due in QuickBooks. The printed Sales Order copies on file will serve as 
supporting documentation. 

j. You can download a copy of this example template from www.CarltonCollins.com 
– click the Excel Link. 
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Gantt Charts 
 
Let’s start by tricking Excel into creating a Gantt Chart. Of course Excel does not do Gantt charts, 
so we will apply clever tricks to achieve the desired affects. It’s really not that hard and it works 
just as well in Excel 2013, 2010, 2007 and 2003. Start by preparing a simple list of tasks including 
start dates, duration of each task, and end dates (formulas in Excel can calculate the end dates). 
An example is shown below: 
 

 
 

1. Start by creating a stacked bar chart  
2. Remove the Data Series by right mouse clicking and choosing Select Data Source 
3. Add a new Data Source Named Starting Date, and point to the range of start dates for the values 
4. Add another new data source named Duration (Days), and point to the range of duration days 

for the values 
5. Add Category Axis Labels and point to the Task names in Column A 
6. Remove legend by selecting legend and pressing the Delete key 
7. Click on the beginning series and set the Fill and Borders to None 
8. Right mouse click on the task labels, choose format Axis, and check the Categories in Reverse 

Order box (if needed) 
9. In two blank cells, write a formula referencing the start and end dates, convert these dates to 

numbers with formatting 
10. Use the resulting numbers to set the scale of the Gantt Chart (perhaps use a slightly larger range 

of dates) 
11. Right mouse click on the date range, set the minimum and maximums to fixed using the 

numbers acquired in the above step 
12. Format the date range to show a short date 
13. Format the remaining data bars to display a 3-D bevel 
14. For added touch, search Google images for a nice picture of a house, save it to your hard drive. 
15. Set the background plot area to picture, and wash out the picture enough so that the chart is 

still readable. 
16. Add a title or text boxes as needed to complete the description of the Gantt Chart 
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The resulting Gantt chart is shown below. At this point, changing any of the start dates or 
duration dates will automatically update the Gantt chart. 
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Combination Charts 
 
A combination chart is used to show one chart on top of another 
chart, using the same scale by percentage. This allows the reader to 
better study the data to determine whether relationships, if any, 
exist between the two sets of data. For example, consider the simple 
study hours and resulting grade information shown to the right for a 
new college student – we will call him Austin. We have compiled a 
worksheet showing the number of hours in which Austin studied 
each week, and the average scores he achieved on his homework, 
quizzes, test and exams.  
 

1. Start by creating a line chart from your entire data range 
2. Rescale the top line by right clicking and change the series 

option to use a secondary axis 
3. Note the ranges on each side of the chart 
4. Next right mouse click one of the lines and choose Change 

Series Chart type, and choose a column chart format 
5. Now apply a chart format and study your date for any useful 

relationships 

 
 

 
 
As we can see by the resulting combination chart, approximately 26 hours of study are required 
each week in order to achieve an average grade of 90 or above, and approximately 20 to 22 hours 
of study are required each week to achieve a B average above 80. In our next case study we might 
want to analyze whether the amount of money his parents send to him each week affects the 
number of hours of study he puts forth each week.  
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Organization Charts 
 
Next we will create an organizational chart using the SmartArt capabilities in Excel 2013, 2010, 
and 2007. Excel 2003 offers a similar tool, but it is not as pretty. Start by choosing SmartArt and 
point to the desired chart format.  

  

http://www.carltoncollins.com/


Excel 2013 for CPAs 

www.CarltonCollins.com Page 132 Copyright May 2013 

 

What’s New in Microsoft Office 2013? 
 
This course covers 8 hours of the very best and most essential Excel 2013 functionality that CPAs 
should be using in the performance of their jobs. This course is best suited for moderate level 
Excel users who know how to use the basic functionality of Excel, but have seldom explored the 
more powerful features and capabilities that Excel has to offer, including the following new 
features found in Excel 2013.  
 
1. Quick Analysis - helps you analyze data more quickly by offering data layouts. 
2. Flash Fill - watches you work and applies logic to help you complete your tasks.  
3. PowerView - enables you to create new report types, such as the interactive map charts. 
4. Timeline Slicer - helps you slice and dice Pivot data containing dates. 
5. Create Relationships tool – enables you to build PivotTables from multiple data sources.  
6. Drill Up and Cross Drill - Drill upward and cross drill to related tables. 
7. Improved Edit Mode - edit mode, Excel no longer displays an apostrophe. 
8. Excel Instances - Excel now opens each workbook in a separate instance.  
9. New PivotTable Tools - decouple PivotCharts so they stand alone. 
10. Fifty New Functions – Bring the total number of functions to 450. (1) 
11. Recommended Pivot Tables & Charts – To help you work quicker and easier. 
12. New Chart Controls - Excel pops up new chart controls.  
13. Get A Link – Send Excel workbooks links instead of workbooks via email. 
14. Publish Excel Data to Social Media – Embed Workbooks directly in Facebook. 
15. Review Tools - new inquire Add-in reviews design, function and data dependencies. 
16. Excel Compare tool - similar to Word’s Compare tool. 
17. Touch-Screen Enabled – Makes excel accessible on touch-screen mobile devices. 
18. Windows 8 Style Tiles – For easy launching and navigation. 
19. Cloud-Enabled – Save Excel workbooks directly to your free cloud data storage SkyDrive. 
20. Office 2013 Web Apps – a free version of Excel 2013 is available via the cloud. 
21. Subscription Pricing – enables you to install Excel on five devices, and run Excel from the cloud. 

 
These concepts are described in greater depth below. 
 

 
 

Many CPAs worry that Office’s new touch-screen functionality means the product’s new 
ribbons that will be time-consuming to learn, but this is not the case. Office 2013’s ribbons work 
and look almost exactly like Office 2010’s ribbons, and transitioning to the new product involves 
only a minor learning curve. While the new touch-screen controls provide new ways to launch 
and use the applications on touch-screen devices, the 2010-style ribbon along with a standard 
keyboard and mouse remains to be the primary means for operating the product. On mobile 
devices, the ribbons offer the same menu options, but they are redesigned to better fit smaller 
hand-held devices. Most of Office’s new touch controls work similar to mouse-clicks, but new 
gestures have been added. For example, you can navigate Excel workbooks or multiple pages in 

New Global Features in Office 2013 
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Word by swiping your finger across the screen. You can also pinch and spread to shrink or enlarge 
your spreadsheets, documents or presentations. A new Touch Mode button inserts more space 
around the Ribbon’s icons so operating the touch controls on smaller devices is a little easier.  

 
 Office’s new square, color-coded tiles (see figure) are used to launch applications on your 
tablet, smartphone, or computers equipped with touch-screen monitors. The tiles can be resized 
and rearranged to your preference, and the color-coded schemes make it easier to identify and 
select the correct application. Office’s tiles match the Windows 8 tiles which have been praised 
by some for their simplicity and utility. 

 

  
Examples of Office 2013 Quick Launch Tiles in Windows 8 

 
Office binds you to the cloud in many ways. For example, Office automatically connects 

to your free cloud-based SkyDrive which includes 20 GBs of data storage space, email account, 
contact management, calendar management, and the following free web apps: 2013 editions of 
Word, Excel, PowerPoint, and OneNote. These web apps are cloud-based versions of the popular 
applications (with limited commands and features), accessible from any web browser on a 
desktop, laptop, tablet or smartphone device.  
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Office 2013's Free Web Apps 

 

Since everyone has access to these free web apps, troublesome file-sharing barriers and 
file compatibility issues are removed; therefore, CPAs can use Office 2013 with the confidence of 
knowing that documents and workbooks they produce can be easily viewed and edited by others. 
(These web apps are available for free by signing up for a SkyDrive account as described in the 
October, 2011 JofA article titled A Sky-High Solution - page 78).   

 

Microsoft offers Office via a subscription plan and many CPAs are finding the rental plan 
to be a better option than purchasing the product. Pricing options and functionality for selected 
Office 2013 editions are summarized in the table below. 

 
 

Office Edition 
 

Users/PCs Price Included 

 
Purchase Options: 

Office Home & Business 1 user/3 PCs $279.99 Word, Excel, PowerPoint, OneNote, 
Outlook 

Office Professional 1 user/2 PCs $499.99 Word, Excel, PowerPoint, OneNote, 
Outlook, Access, Publisher 

 
Subscription Options: 

Office 365 Professional Plus 1 user/5 PCs $15/Month Word, Excel, PowerPoint, OneNote, 
Outlook, Access, Publisher 

Office 365 E3 Plan 1 user/5 PCs $20/Month Word, Excel, PowerPoint, OneNote, 
Outlook, Access, Publisher, Cloud-
based email, Web conferencing, 

Shared calendars, Cloud-based team 
sites, Office Web Apps 

Pricing Options for Selected Editions of Office 2013 

 

Seven advantages for renting rather than purchasing are as follows: 
 
1. Installs on more PCs - The subscription plan allows you to install Office professional on five 

computers or devices, compared to just two or three installations with the purchased product.  
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2. Never upgrade again – Renters will never face an upgrade decision again as future product 

enhancements are included automatically.  
 
3. Superior iMap email - The subscription plan includes a cloud-based email solution using iMap 

(Internet Message Access Protocol), which is stronger than the traditional Pop3 (Post Office 
Protocol) email solution. This is because iMap maintains email messages, replies, contacts, 
tasks and calendars in a central location so you can access them from any of your computers, 
the web, or mobile devices. In contrast, Pop3 maintains this information on the individual 
computers, thus accessing this information from multiple computers or devices is more 
problematic. 

 
4. Better security - In the cloud, data is securely encrypted from your computer to the cloud, 

and your data remains encrypted in the cloud. Your data is also backed up automatically on a 
continuous basis and is protected by world-class firewalls, anti-virus software, and intrusion 
monitoring solutions. A significant amount of technology, cost and effort is needed to 
duplicate this level of security on a local computer or file server. 

 
 
5. File Sharing – The subscription plan includes a cloud-based SkyDrive (starting at 20 GBs), team 

management tools, and file syncing options to help groups work in collaboration. You can 
grant permission to others to access your SkyDrive files or folders, even if they don’t use 
Office. In the cloud environment, email attachments are unnecessary because you can send 
recipients a link instead of attachments; as a result, emails travel faster, deliveries are no 
longer hung up due to attached file size restrictions, and attachments no longer contribute to 
oversized inbox data files.  
 

6. Eliminate upfront capital costs – For larger companies, the subscription plan eliminates their 
need to borrow money to purchase product. By opting for the “pay as go” subscription plan, 
companies can expense the costs as a monthly operating expense;  

 
7. Eliminate balance sheet liabilities – For larger companies, FASB 47 requires disclosure of long 

term obligations, but because Office’s subscription plan requires no long-term commitment, 
these rental obligations need not be included on the balance sheet. 

 
 

 
 

Of all the Office 2013 applications, Excel is the beneficiary of the most impressive 
enhancements. Excel’s new Flash Fill watches you work and applies logic to help you complete 
your tasks. The example pictured below (see figure below) contains a list of 44 first and last names 
in Column A, which I want to separate into Columns B and C. As I start typing the first name of 
the second record in Column B; Excel’s Flash Fill guesses what I’m trying to do and offers to fill in 
the remaining 42 first names (as shown in grey text). 

  

New Features in Excel 2013 
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Excel's New Flash Fill Tool 

 

Excel’s new PowerView inserts new worksheets connected to your data, and then 
enables you to create new report types, such as the interactive map chart presented in figure 4. 
The resulting PowerView Map report is zoomable, and filters can be applied to display partial 
data. 

 

 
PowerView Tool Depicting a New Zoomable Map View 

 

http://www.carltoncollins.com/


Excel 2013 for CPAs 

www.CarltonCollins.com Page 137 Copyright May 2013 

 

PowerView worksheets can be published as standalone, interactive reports to Microsoft 
SharePoint’s PowerPivot Gallery or other reporting service destinations. Some of the tools 
provided by PowerView include the ability to create a dashboard containing multiple 
PowerViews, apply themes and backgrounds, insert pictures and text boxes, insert collapsible 
and expandable tiles, and add data slicers. CPAs who work with PivotTables will likely appreciate 
Excel’s new Timeline Slicer which helps users slice and dice Pivot data that contain dates. As an 
example, selecting the dates May through October on the Timeline slicer (pictured) adjusts the 
PivotTable to display May thru October data.  

 

 
Excel's New Timeline Slicer provides a  

Visual Method of Filtering a PivotTable by Date 

 

As an advanced enhancement, Excel provides the new Create Relationships tool for 
building table relationships in workbooks that contain at least two tables sharing at least one 
common field name.  

  

 
Excel's New Relationship Tool for Pivoting Multiple Sources of Data 

 

Once relationships are established, the More Tables option can be used to display 
additional tables allowing you to add data fields from mutiple tables to PivotTables, as pictured. 
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Connecting Multiple Sources of Data to a PivotTable 

 

Another PivotTable enhancement involves drillability. Previously, users could only drill 
down on PivotTable data, but now you can also Drill Up and Cross Drill to related tables.  

 
Excel offers new tools which can analyze your data and recommend a variety of 

PivotTable and Chart layouts to best illustrate the data. This new functionality is especially useful 
to novice users who are less familiar with Excel’s functionality, but can also help avid Excel users 
save time too. Simply place the cursor anywhere in your data area and select Recommended 
PivotTables (or Recommended Charts) and in return, Excel offers various PivotTable and Chart 
options and as pictured in the figure. 
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Excel's New Recommend PivotTables and Recommend Charts Tools 

 
Excel’s Quick Analysis tool also helps you analyze data by offering a variety of formatting, 

charts, totals, tables and sparkline layouts to instantly summarize large volumes of data (see 
figure). When using Quick Analysis to scrutinize text-only data, text specific options for 
highlighting duplicate or unique text items appear. 
 

 
Example of Excel's New Quick Analysis Tool 

 

Microsoft has added 50 new functions to Excel (increasing the total number of functions 
to 450), and the following 12 new functions in particular will appeal to many CPAs. 

 
1. ARABIC – Converts roman numerals to regular numbers, for example V, IX, and XX are converted 

to 5, 9, and 20. 
 

2. CEILING.MATH – This function can be used to round a number up to a specific interval, such as 
the nearest 99 cents, as demonstrated in figure 10. 
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Example Use of Excel's New Ceiling.Math Function 

 
3. DAYS – Calculates the number of days between two dates. 

 
4. FLOOR.MATH - Rounds numbers down to a specific interval, and also can be used to round 

negative numbers towards zero, instead of towards a smaller number. For example, -8.5 can be 
rounded to -8.0 (instead of the -9.0 results delivered by the older Round function).  

 
5. FORMULATEXT – Displays referenced formulas as text, and can be used to improve formula 

reading, reviewing and printing. 

 
6. ISFORMULA – Returns the value TRUE if the referenced cell contains a formula. 

 
7. ISOWEEKNUM – Calculates the week during the year in which a given date falls. As an example, I 

used this formula to determine that I was born in the 53rd week of 1959. 

 
8. PDURATION - Returns the number of periods required by an investment to reach a specified 

value. For example, you could calculate that $1,000 invested at 6% APR would take 26.89 years to 
reach a value of $5,000. (This function approach is faster than constructing a 322 row table to 
figure this out.) 

 
9. RRI – This function returns an equivalent interest rate for the growth of an investment. For 

example, you could calculate that a $1,200 mutual investment that grew to $5,600 in 18 years 
earned an average return of 8.93%. 

 
10. SHEET – Calculates the sheet number of the referenced sheet. For example, you might use this 

function to determine that your interest rate assumptions are entered on the 46th sheet in your 
workbook. 

 
11. SHEETS – Calculates the total number of sheets in a referenced range.  

 
12. SKEW.P – Like the Skew function, SKEW.P calculates the standard deviation of a string of data, 

but bases its calculation on the entire population instead of a sample of the population. This 
function could be used to determine whether each line item of a company’s historical financial 
statement data is consistent enough to use as a basis for projecting the following year’s budget.  

 
For a complete listing of the 50 new functions in Excel 2013, visit 

www.carltoncollins.com/newfun.htm or scan the tag. 
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What’s New in Microsoft Office 2010? 
 

1. Office Button Is Replaced With File Tab – Excel 2007 included the Office Start button, 
which was not intuitive to anybody, despite what Microsoft said.  In Excel 2010, Microsoft 
Office axed the office Start button in favor of the File tab. YIPPY! 

 
2. Backstage View – The file tab provides new look and feel called “Backstage View”. This 

new view represents one of the biggest differences you’ll notice in Microsoft Excel 2010. 
Backstage View is displayed by clicking on Excel’s File tab, as in all the other applications 
that comprise Office 2010. The backstage view in is available in the other Office 2010 
applications, and each application uses a different color scheme to differentiate it from 
the others. In Excel 2010, the color scheme is green. 
  
In general, Backstage View provides basically the same commands found under the File 
menu in previous version of Excel such as Save, Save As, Open, Close, Print, etc. What’s 
new is the preview screen and info tabs that accompanying some of these selections. For 
example, when you select the print option, a preview of the print job is automatically 
displayed, as shown below. 
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The Print option Backstage View also provides access to various Page and Print settings, 
such as Duplexing, Orientation, Margins, and Scaling. The save and Send option also has 
a new look and feel, providing buttons for emailing, publishing, and saving files, as well as 
options to create PDF or XPS documents.  
 

 
The New option also incorporates a new look and feel with thumbnail previews of 
templates, and links to downloading more templates from the Web. 
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If you want to return to the old Excel 2007 look and feel when you click the File tab (not 
that you would want to), you can change registry settings, as detailed in this article on 
Turning Off The Microsoft Office 2010 OutSpace located here: 
 

http://www.off14.com/microsoft-office-2010-outspace/ 
 
(They’ve actually got the name wrong in this article; although the registry key is named 
“outspace”, the display is called Backstage View.)  
 

3. Double Clicking Fill Handle Uses Connected Columns For Fill Down – In previous versions of 
Excel, the double click only worked if data were located in the column immediately to the left 
or right of the range to be copied, but Excel 2010 will use more distant columns provided they 
are connected with a common set of column labels.  
 

4. Custom Lists Obey Character Case Example – When using the Smart List feature, Excel 2010 
obeys the case (proper, lower, and upper) that is used in your starting phrase.  

 
5. Remove Hyperlinks (Instead Of One Hyperlink at A Time In 2007 And 2003) – In earlier 

versions of Excel, you could only remove one hyperlink at a time (the work around is to copy 
and paste a range containing hyperlinks and paste them as text elsewhere, then copy and 
paste that result back to your original location. Excel 2010 can remove all hyperlinks from a 
range in just one step. 

6. Sparklines – Sparklines are small cell-sized charts that you can embed in a worksheet next to 
data to get a quick visual representation of the data. For example, if you had a worksheet that 
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tracked the performance of several dozen stocks, you could create a Sparkline for each stock 
that graphed its performance over time, in a very compact way. Here are examples: 

 
 

7. Conditional Formatting Improvements – Microsoft has improved and added more styles and 
icons regarding the ability to apply a format to a range of cells, and then have the formatting 
change according to the value of the cell or formula.  

 
a. Solid Bars - Data Bars can be solid now in Excel 2010. Excel 2007 bars offered only a 

gradient effect, which was visually was confusing to read. Below is a comparison on the 
Excel 2007 and Excel 2010 Data Bar options.  

 

  
 

b. Negative Numbers - Microsoft also corrected a problem which Excel 2007 had creating 
when Data Bars based on negative numbers by adding axis support for both positive and 
negative values. The screens shots below show Excel 2010’s new solution, and how Excel 
2007 got confused when applying Data Bars to the exact same data. 

 

   2007 Gradient           2010 Gradient       2010 Solid 
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c. More Data Bar Options - Notice that Microsoft added more Data Bar options as shown in the 
comparison below. 

 
 

 
 

d. More Icon Options - Notice that Microsoft added more Data Bar options as shown in the 
comparison below. 

              Excel 2010’s Data Bars               Excel 2007’s Data Bars 

           Excel 2010’s Data Bar Menu            Excel 2007’s Data Bar Menu 
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e. Arrow Colors - It is possible to change icons used for KIP i.e. You can have two arrows with 
different colors of if negative impact and positive growth are good for you. 

 
f. Referring to Data - You can now refer to data on different worksheets, and even refer to a range 

outside the Conditional Formatting area. The screen below shows the error message produced by 
Excel 2007 when you attempted to reference cells outside the Conditional Formatting area; Excel 
2010 now accommodates this situation. 

              Excel 2010’s Icon Menu         Excel 2007’s Icon Menu 
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8. Microsoft Excel Web App’s Improved Sharing – Excel 2010 has new and improved tools for 
sharing data with other people, including multiple people working on the same document at 
the same time. Excel Web App extends your Excel experience to the web browser, where you 
can work with workbooks directly on the site where the workbook is stored. Excel Web App 
is part of Microsoft Office Web Apps, and is available in Windows Live SkyDrive and in 
organizations that have configured Office Web Apps on SharePoint 2010. With Excel Web 
App, you can: 

a. View - View a workbook in the browser - When you click on a workbook to open 
it in Excel Web App, the workbook is displayed in view mode.  

b. Sort and Filter - You can sort and filter data in the workbook, expand PivotTables 
to see relationships and trends in the data, recalculate values, and view different 
worksheets. 

c. Browser-Based Editing - Edit a workbook in the browser - With Excel Web App, all 
you need to access your workbooks is a browser.  

d. Share - Your teammates can work with you, regardless of which version of Excel 
they have.  

e. Looks the Same - Your workbooks look the same in the browser as they do in Excel.  
f. Excel Tools - You can edit your worksheets in the browser, using the familiar look 

and feel of Excel. When you edit in the browser, you can change data, enter or 
edit formulas, and apply basic formatting within the spreadsheet.  

g. Simultaneous Access - You can also work with others on the same workbook at 
the same time. 

 
Microsoft offers a free solution called Windows Live SkyDrive, which enables everyone in your 
group to share Word and Excel (and other) documents. This solution also provides users with 
Word, Excel and PowerPoint applications (with limited functionality) so your group members 
can work in the same applications.  
 

Excel 2007 
Error 

Message 
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To use SkyDrive, sign up for a free Windows Live account at http://explore.live.com/. Under 
the SkyDrive menu, select Get started and follow the instructions for setting up a Windows 
Live account. Once you have completed the registration process, sign into your Windows Live 
Sky Drive account and click the Office menu option at the top of the screen to view your 
SkyDrive as follows: 
 

 
 
Next create a folder and upload (or create) the group’s Word and Excel files. Select the folder 
and click the Share menu option as shown to edit permissions and to send links to your group 
members, which will enable them to access the data files.  

 
When sharing files in this manner, to better protect your data, check the checkbox labeled 
Require recipients to sign in with Windows Live ID. This action will require your group 
members to obtain their own Windows Live accounts and use their passwords in order to 
access the data files. Otherwise, anyone who receives the link will be able to access the data 
files.  
 
Notes: The free version of Windows Live Sky Drive is limited to 25 GBs of storage, and 
individual files are limited to 50 MBs. For a fee, you can increase these capacities. Installing 
Microsoft’s free Silverlight browser add-in will enable drag and drop functionality to and from 
your SkyDrive. The Windows Live SkyDrive solution was first introduced in August 2007, and 
is widely used.  

http://www.carltoncollins.com/
http://explore.live.com/windows-live-skydrive?wa=wsignin1.0


Excel 2013 for CPAs 

www.CarltonCollins.com Page 149 Copyright May 2013 

 

 
9. Customize the Ribbon Toolbar - The Ribbon tool bar has been enhanced, and is now highly 

customizable. For example, you can add your own tabs to the Ribbon (as shown below), you 
can add your own groups to each tab (also shown below), and you can add any commands or 
macros to your customized tabs and groups.  

 
 

10. Compatibility of .xlsx - In Excel 2007, Microsoft introduced a new XML format (.xlsx) which was not 
compatible with former .xls spreadsheet formats. This problem has been resolved - Excel files created 
in Excel 2010 may easily be opened in versions of Excel prior to Excel 2007. Now Excel 2010 will save 
files just as safe as the former Excel 2007, and the spreadsheet size is 75% smaller than the old .XLS 
version. 

 

 
 
11. Protected Mode - Excel 2010 includes a Protected View, so you can see the document and make a 

more informed decision before exposing your computer to possible vulnerabilities. By default, 
documents that originate from an Internet source are opened in Protected View. When this happens, 
you see a warning on the Message bar, along with the option to enable editing. You can control which 
originating sources trigger Protected View. You can also set specific file types to open in Protected 
View regardless of where they originate. Excel will not allow you to edit the documents unless 
document editing is enabled. To do this, click the Enable Editing option in order to enable document 
editing as shown in the following screen shot. 
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12. Trusted Documents - The trusted documents feature is designed to make it easier to open 
workbooks and other documents that contain active content, such as data connections or macros. 
Now, after you confirm that active content in a workbook is safe to enable, you don’t have to 
repeat yourself. Excel 2010 remembers the workbooks you trust so that you can avoid being 
prompted each time you open the workbook. 
 

13. Slicer - The Slicer feature provides new slice and dice capabilities within PivotTables – this helps 
you dynamically segment and filter the data. This feature is located on the Insert Tab. 

 

 
 

14. Macro - Macros in Excel 2010 now support working with shapes, including creating, moving or 
editing shapes. For example, you could now record a macro that automatically insert s the 
following SmartArt object. 

 
15. Enhanced Chart Diagram - In Excel 2010 double clicking a chart element automatically opens 

the chart’s format dialog box. 
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16. 64-bit version of Excel 2010 - Excel 2010 is now available in a 64-bit version, which means 
that it can take full advantage of your computer’s 64-bit motherboard and access more 
than 4 GBs of RAM. The result is even faster performance. 
 

17. Microsoft SQL Server PowerPivot for Excel - Excel 2010 now includes an add-in tool called 
Microsoft SQL Server PowerPivot which is a Business Intelligence tool that enables you to query 
multiple SQL Server databases across multiple corporate systems and web data on a real-time 
basis to produce PivotTables that can be shared via SharePoint. You can try this online at the 
following Virtual Labs web site:  
 

https://cmg.vlabcenter.com/prepare.aspx?moduleid=ad3bd3e9-8d2b-498d-94fa-
e41e1b09730d&ticks=633992819904236083. 

 

Microsoft now offers Project Gemini add-on for Excel 2010 that can handle very large 
amounts of data -- even worksheets that include hundreds of millions of rows. It will ship 
as part of SQL Server 2008 R2 in the first half of 2010; a community technology preview 
will be available in the second half of 2009. 

 

18. What-If with Write-Back - PivotTable What-If Analysis is the ability to modify values in 
PivotTable cells, recalculate the PivotTable with those values and, if the results are 
satisfactory, publish the changes so that they are reflected in the OLAP data source for 
other people to see. This feature is also called write back, though it really goes beyond 
just the ability to write values back to the cube. “What if our sales for New York increased 
by 10%?” “What if the total number of product orders fell by 25%?” These are examples 
of questions that PivotTable What-If Analysis is aimed at helping the user answer. Let’s 
take a look at the following scenario: 

 
Stephen, the sales manager at a small IT company, is trying to figure out what his optimal 
sales quotas should look like for 2010. Based on a previous analysis and forecasts for next 
year it seems like 2010 will have a large decrease in sales which would mean his quotas 
would be reduced by 10% from the 2009 quotas. With the new PivotTable What-If 
Analysis feature he can now modify the relevant values in his PivotTable report and 
calculate the PivotTable with the changes to see what the totals would look like without 
actually modifying the data source. (click to see larger image) 
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So here is what his PivotTable looks like after calculating with the changes: 

 
If he wants to keep these numbers and share them with other people he can go ahead 
and publish the changes to the OLAP data source. 

 
He can also just keep the changes locally without publishing back to the OLAP data source 
by simply saving the file. When the workbook is loaded again in Excel 2010 all the changes 
will be reapplied and the PivotTable recalculated. With little knowledge of OLAP data 
sources the manager was able to change values and recalculate his PivotTables. The 
changes can be shared across the organization by simply sharing the workbook or 
publishing the changes back to the OLAP data source. 
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Advanced Options - Advanced options for PivotTable What-If Analysis include being able 
to change the allocation method, which is the methodology in which the OLAP data 
source will allocate the newly entered values in the cube. Excel 2010 also gives you the 
ability to define your own weight allocation definitions from within an MDX editor.  
 

19. Recover Earlier Versions Of A File In Office 2010 - It is now easier to recover a Microsoft 
Word 2010, Microsoft Excel 2010, or Microsoft PowerPoint 2010 file if you close your file 
without saving, or you want to review or return to an earlier version of the file you're 
already working in.  

 

As with earlier versions of Office, enabling AutoRecover in Word 2010, Excel 2010 or 
PowerPoint 2010 will save versions while you are working in your file at the interval you 
select. Now, you can choose to keep the last autosaved version of a file in case you 
accidentally close that file without saving, so that you can restore it the next time that 
you open the file. Also, while you are working in your file, you can access a listing of the 
autosaved files from the Microsoft Office Backstage view. 

  

Note: You must have the “Save AutoRecover information” and “Keep the last autosaved 
version if I close without saving” enabled for these features to work. (The Recover 
Unsaved Workbooks option is available from the File tab, under the Recent menu option.  
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20. Named Sets - Named Sets have been added to Microsoft Excel 2010, allows you to create your 

own named sets. Simply locate the Fields, Items, & Sets button under the Ribbon, and it will allow 
you to define your own Named Sets. 

 
21. Excel Mobile 2010 for Windows Phone 7 - If you have Windows Phone 7, you can use 

Microsoft Office Mobile 2010 to work with your files from anywhere—whether you’re at 
work, at home, or on the go. Excel Mobile 2010 is part of Office Mobile and already on 
your phone in the Office Hub, so you don't need to download or install anything else to 
get started. 

 

You can use Excel Mobile to view and edit workbooks stored on your phone, sent to you 
as email attachments, or hosted on a SharePoint 2010 site through SharePoint Workspace 
Mobile 2010. When you edit a workbook via SharePoint Workspace Mobile, you can save 
your changes back to the SharePoint site when you’re online. You can create, update, and 
instantly recalculate your spreadsheets using many of the same tools you already know 
and use in the desktop version of Excel: 

a) Use the outline view to switch between worksheets or charts in a workbook. 
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b) Sort, filter, and manage your spreadsheets.  
c) Add or edit text and numbers. 
d) Add comments. 

22. Improved PivotTables 

PivotTables are now easier to use and more responsive. Key improvements include: 

a) Performance - In Excel 2010, multi-threading helps speed up data retrieval, sorting, 
and filtering in PivotTables. 

b) PivotTable Labels - It's now possible to fill down labels in a PivotTable. You can also 
repeat labels in PivotTables to display item captions of nested fields in all rows and 
columns. Watch a video about repeating item labels. 

c) Enhanced Filtering - You can use slicers to quickly filter data in a PivotTable with the 
click of a button and see which filters are applied without having to open additional 
menus. In addition, the filter interface includes a handy search box that can help you 
to find what you need among potentially thousands (or even millions) of items in your 
PivotTables. 

d) Write-back Support - In Excel 2010, you can change values in the OLAP PivotTable 
Values area and have them written back to the Analysis Services cube on the OLAP 
server. You can use the write-back feature in what-if mode and then roll back the 
changes when you no longer need them, or you can save the changes. You can use 
the write-back feature with any OLAP provider that supports the UPDATE CUBE 
statement. 

e) Show Values As feature - The Show Values As feature includes a number of new, 
automatic calculations, such as % of Parent Row Total, % of Parent Column Total, % 
of Parent Total, % Running Total, Rank Smallest to Largest, and Rank Largest to 
Smallest. Watch a video about changes to the Show Values As feature. Watch a 
video about changes to the Show Values As feature. 

f) PivotChart Improvements - It is now easier to interact with PivotChart reports. 
Specifically, it's easier to filter data directly in a PivotChart and to reorganize the 
layout of a PivotChart by adding and removing fields. Similarly, with a single click, you 
can hide all field buttons on the PivotChart report.  

 
23. Improved Solver Add-In - Excel 2010 includes a new version of the Solver add-in, which 

you can use to find optimal solutions in what-if analysis. Solver has an improved user 
interface, a new Evolutionary Solver, based on genetic algorithms, that handles models 
with any Excel functions, new global optimization options, better linear programming and 
nonlinear optimization methods, and new Linearity and Feasibility reports. In addition, 
the Solver add-in is now available in a 64-bit version. 
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Use Solver to determine the maximum or minimum value of one cell by changing other 
cells. For example, you can change the amount of your projected advertising budget and 
see the effect on your projected profit amount. 

 

Example of a Solver problem - In the following example, the level of advertising in each 
quarter affects the number of units sold, indirectly determining the amount of sales 
revenue, the associated expenses, and the profit. Solver can change the quarterly 
budgets for advertising (cells B11:E11), up to a total budget constraint of $40,000 (cell 
F11), until the value for the total profit reaches the maximum possible amount. The 
values in the decision variable cells are used to calculate the profit for each quarter, so 
the values are related to the formula in the target cell F15, =SUM(B15:E15). 

 

 

Decision variable cells 

Constraint cell 

Objective cell 

 

After Solver runs, the new values are as follows. 

 

 
For more solver examples, check out:  
http://www.solver.com/excel2010/solverhelp.htm  
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24. Improved Function Accuracy - Excel 2010 includes more accurate statistical and other 
functions. Certain existing functions have also been renamed to better describe what they 
do, as follows:  

a) Accuracy Improvements - A number of functions have been optimized to improve 
accuracy. For example, Excel 2010 returns more accurate results for the beta and chi-
squared distributions. 

 

b) More Consistent Functions - Certain statistical functions have been renamed so that 
they are more consistent with the function definitions of the scientific community and 
with other function names in Excel. The new function names also more accurately 
describe their functionality. Workbooks created in earlier versions of Excel will 
continue to work despite these name changes, because the original functions still exist 
in a Compatibility category. 

 

25. Improved Filter Capabilities - In addition to slicers, which are described earlier in this 
article, Excel 2010 comes with new features that make it easier to sort and filter data, as 
follows. 

 
a. New search filter - When you filter data in Excel tables, PivotTables, and 

PivotCharts, you can use a new search box, which helps you to find what you need 
in long lists. For example, to find a specific product in a catalog that stocks over 
100,000 items, start by typing your search term, and relevant items instantly 
appear in the list. You can narrow the results further by deselecting the items you 
don't want to see. 
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b. Filter And Sort Regardless Of Location - In an Excel table, table headers replace 
regular worksheet headers at the top of columns when you scroll down in a long 
table. AutoFilter buttons now remain visible along with table headers in your table 
columns, so you can sort and filter data quickly without having to scroll all the way 
back up to the top of the table.  

 

26. Performance Enhancements - Performance improvements in Excel 2010 can help you to 
interact with your data more efficiently. Specific investments include: 

 
a) General improvements - Excel 2010 is more responsive when you move and resize 

charts, work in Page Layout view, and interact with shapes on the worksheet.  

b) Support For Large Data Sets - Excel 2010 handles workbooks that contain massive 
amounts of data more efficiently. Specifically, it takes less time to perform activities 
commonly performed on large data sets, such as filtering and sorting the data, copy 
and pasting it from one worksheet to another, and using the Fill feature to copy 
formulas.  
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c) Multicore Improvements - Multithreading improvements in Excel 2010 help to speed 
up the process of retrieving, sorting, and filtering data in PivotTables and Excel tables. 
In addition, opening and saving large files is generally faster than before. 

d) Faster Calculation - To achieve faster calculation performance, Excel 2010 includes 
support for asynchronous user-defined functions, which can run simultaneously 
without using multiple Excel calculation threads.  

27. Improved Charting - It's now easier to work with charts in Excel 2010. Specific 
improvements include: 

 
a) New Charting Limits - In Excel 2010, the limitation on the number of data points that 

can be created on a chart has been removed. The number of data points is now limited 
only by available memory.  

b) Quick Access To Formatting Options - In Excel 2010, you can instantly access 
formatting options by double-clicking a chart element. 

c) Macro Recording For Chart Elements - In Office Excel 2007, recording a macro while 
formatting a chart or other object did not produce any macro code. In Excel 2010, 
however, you can use the macro recorder to record formatting changes to charts and 
other objects. 

28. Support for Equations - You can use the new equation editing tools in Excel 2010 to insert 
common mathematical equations into your worksheets or to build up your own equations 
by using a library of math symbols. You can also insert new equations inside of text boxes 
and other shapes. To get started, on the Insert tab, in the Symbols group, click the arrow 
next to Equation.  
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29. More Themes - In Excel 2010, there are more themes and styles than ever before. These 
elements can help you apply professional designs consistently across your workbooks and 
other Microsoft Office documents. Once you select a theme, Excel 2010 does the design 
work. Text, charts, graphics, tables, and drawing objects all change to reflect the theme 
you have selected, so that all elements in your workbook visually complement one 
another. 
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30. Paste With Live Preview - The paste with live preview feature enables you to save time 
when reusing content within Excel 2010 or across other programs. You can use it to 
preview various paste options, such as Keep Source Column Widths, No Borders, or Keep 
Source Formatting. The live preview enables you to visually determine how your pasted 
content will look before you actually paste it in the worksheet. When you move your 
pointer over Paste Options to preview results, you'll see a menu containing items that 
change contextually to best fit the content you are reusing. ScreenTips provide additional 
information to help you make the right decision. 

 

31. Improved Picture-Editing Tools - If you use photos, drawings, or SmartArt to 
communicate visually, you can take advantage of the following features:  

 
a) Screenshots - Quickly take a screenshot and add it to your workbook, and then use 

the tools on the Picture Tools tab to edit and improve the screenshot. 

 

b) New SmartArt Graphic Layouts - With new picture layouts, you can tell your story 
with photographs. For example, use the Captioned Picture layout to show pictures 
with nice-looking captions underneath.  
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c) Picture Corrections - Fine tune the color of a picture, or adjust its brightness, contrast, 
or sharpness—all without having to use additional photo-editing software.  

d) New and Improved Artistic Effects - Apply different artistic effects to your picture to 
make it look more like a sketch, drawing, or painting. New artistic effects include 
Pencil Sketch, Line Drawing, Watercolor Sponge, Mosaic Bubbles, Glass, Pastels 
Smooth, Plastic Wrap, Photocopy, Paint Strokes, and many more.  

e) Better Compression And Cropping - You now have better control of the image quality 
and compression tradeoffs, so that you can make the right choice for the medium 
(print, screen, e-mail) that your workbook will be used for. Read more about cropping 
and picture compression. 

32. Accessibility Checker - The new Accessibility Checker tool in Excel 2010 enables you to 
find and fix issues that can make it difficult for people with disabilities to read or interact 
with your workbook. You can open the Accessibility Checker by clicking the File tab, 
clicking Check for Issues, and then clicking Check Accessibility. Errors and warnings will 
appear in a task pane. You can then review the issues and see which ones you need to fix. 
In addition to the Accessibility Checker, you can add alternative text to more objects in 
your worksheet, including Excel tables and PivotTables. This information is useful to 
people with visual impairments who may be unable to easily or fully see the object. 

 
33. Improved Language Tools - In the Excel Options dialog box, multilingual users can quickly 

set preferences for editing, display, ScreenTip, and Help languages. And, changing your 
language settings in Excel automatically changes them across all applicable Microsoft 
Office 2010 applications. If you don't have the software or keyboard layout installed that 
you need, you are notified, and links are provided to make it easier to quickly resolve such 
issues. 
 

34. Improved Programmability Features - Improvements for developers include:  
 

a) Changes to the XLL SDK - The XLL Software Development Kit (SDK) now supports 
calling new worksheet functions, developing asynchronous user-defined functions, 
developing cluster-safe user-defined functions that can be offloaded to a compute 
cluster, and building 64-bit XLL add-ins. 

b) VBA Improvements - Excel 2010 has a number of features that will enable you to 
migrate any remaining Excel 4.0 macros you may have to VBA. Improvements include 
better performance for print-related methods and chart properties not previously 
accessible with VBA. 

c) Better User-Interface Extensibility - If you develop custom workbook solutions, you 
have more options for programmatically customizing both the ribbon and the new 
Backstage view. For example, you can programmatically activate tabs on the ribbon, 
and make custom tabs behave similarly to built-in contextual tabs, where tabs only 
appear when specific events occur. In addition, you can make custom ribbon groups 
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grow and shrink as the ribbon is resized and customize context menus with rich 
controls. You can also add custom UI and other elements to the Backstage view. 

d) Changes to the Open XML SDK - The Open XML SDK 2.0 now supports schema-level 
objects, in addition to the part-level support introduced in the Open XML SDK 1.0. This 
makes it easier to programmatically manipulate workbooks and other documents 
outside the Office 2010 desktop applications—for example, as part of a server-based 
solution. 

35. Sixty One New Functions in Excel 2010 

 

In Excel 2010, Microsoft added 61 new functions and improved 19 others. This page contains a 
summary of those new functions and improvements. CPAs will notice that many of these 
functions are more scientific in nature, or are geared more towards engineers and statisticians. 
However, there are a handful of new functions that apply to the CPA function - particularly when 
it comes to data analysis. I've place a  next to those new functions which I consider more useful 
in standard CPA applications.  
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